Copyright and License

© 2007 Copyright Hewlett-Packard Development Company, L.P.

Reproduction, adaptation, or translation without prior written permission is prohibited, except as allowed under the copyright laws.

The information contained herein is subject to change without notice.

The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

Part number: CC376-90901
Edition 2, 10/2007

Trademark Credits

Adobe®, AdobePhotoShop®, and PostScript® are trademarks of Adobe Systems Incorporated.

ENERGY STAR® and the ENERGY STAR logo® are U.S. registered marks of the United States Environmental Protection Agency.

Corel® is a trademark or registered trademark of Corel Corporation or Corel Corporation Limited.

Microsoft®, Windows®, and Windows®XP are U.S. registered trademarks of the Microsoft Corporation.

Windows Vista™ is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries.
# Table of contents

## 1 Basics
- Product features ................................................................. 2
- Walkaround ........................................................................ 3
  - Front view ........................................................................ 3
  - Back and side view .......................................................... 3
- Control-panel walkaround ..................................................... 4
- USB connection ................................................................... 5
- Model and serial numbers ..................................................... 5

## 2 Software
- Supported operating systems ................................................ 8
- Printer driver ......................................................................... 8
- Priority for print settings ....................................................... 9
- Open the printer driver and change the print settings .............. 10
- Remove product software ...................................................... 10
- Utilities ................................................................................ 11
  - HP Color LaserJet CP1210 Series Toolbox software ................ 11
  - Status Alerts software ...................................................... 11

## 3 Paper and print media
- Understand paper and print media use ................................... 14
- Supported paper and print media sizes .................................... 15
- Supported paper types and tray capacity ................................ 17
- Special paper or print media guidelines .................................. 18
- Load paper and print media .................................................. 19

## 4 Print tasks
- Change the print driver to match the media type and size .......... 22
- Printer-driver Help .............................................................. 23
- Cancel a print job .................................................................. 24
- Create and use printing shortcuts in Windows ......................... 25
- Print booklets ....................................................................... 26
- Print-quality settings ............................................................ 27
- Print on special media .......................................................... 28
- Resize documents .................................................................. 29
- Set the print orientation ........................................................ 30
- Use watermarks .................................................................... 31
- Print on both sides of the page (manual duplex) ....................... 32
Print multiple pages on one sheet of paper in Windows ......................................................... 33

5 Color

Manage color ......................................................................................................................... 36
  Print in Grayscale .................................................................................................................. 36
  Automatic or manual color adjustment ................................................................................. 36
  Manual color options ........................................................................................................... 36
  Color Themes ....................................................................................................................... 37

Advanced color use .................................................................................................................. 38
  HP ImageREt 2400 ................................................................................................................. 38
  Media selection ..................................................................................................................... 38
  Color options ....................................................................................................................... 38
  Standard red-green-blue (sRGB) .......................................................................................... 38

Match colors ............................................................................................................................ 39
  Use the HP Color LaserJet CP1210 Series Toolbox to print the Microsoft Office Basic
  Colors palette ....................................................................................................................... 39

6 Manage and maintain

Print information pages ........................................................................................................ 42

Use the HP Color LaserJet CP1210 Series Toolbox software ................................................. 43
  View HP Color LaserJet CP1210 Series Toolbox .................................................................. 43
  Status ...................................................................................................................................... 44

Help ......................................................................................................................................... 45

Device Settings ...................................................................................................................... 46
  Paper Handling ...................................................................................................................... 46
  Print Quality ......................................................................................................................... 47
  Print Density .......................................................................................................................... 47
  Print Modes ........................................................................................................................... 48
  Paper Types .......................................................................................................................... 48
  System Setup ........................................................................................................................ 48
  Set up Status Alerts ............................................................................................................. 48
  Service .................................................................................................................................. 48
  Shop for Supplies ................................................................................................................ 49
  Other Links ........................................................................................................................... 49

Manage supplies .................................................................................................................... 50
  Print-cartridge storage ......................................................................................................... 50
  HP policy on non-HP print cartridges .................................................................................... 50
  HP fraud hotline and Web site .............................................................................................. 50
  Cartridge out override .......................................................................................................... 51

Replace print cartridges .......................................................................................................... 52

Clean the product .................................................................................................................... 55

7 Solve problems

Basic troubleshooting checklist ............................................................................................... 58
  Factors that affect product performance .............................................................................. 58
  Status-light patterns .............................................................................................................. 59
  Status-alert messages .......................................................................................................... 63
  Jams ........................................................................................................................................ 67
Appendix A  Supplies and accessories

Order parts, accessories, and supplies ................................................................. 84
Order directly from HP ............................................................................................ 84
Order through service or support providers ....................................................... 84
Order directly through the HP Color LaserJet CP1210 Series Toolbox software ... 84
Part numbers ........................................................................................................... 85

Appendix B  Service and support

Hewlett-Packard limited warranty statement ....................................................... 88
Print cartridge limited warranty statement .......................................................... 89
HP Customer Care ............................................................................................... 90
Online Services ....................................................................................................... 90
Telephone support ................................................................................................. 90
Software utilities, drivers, and electronic information ........................................ 90
HP direct ordering for accessories or supplies ................................................. 90
HP service information ......................................................................................... 90
HP service agreements ......................................................................................... 90
HP Color LaserJet CP1210 Series Toolbox ......................................................... 90
HP maintenance agreements ................................................................................ 92
HP Care Pack™ Services and Service Agreements ............................................ 92
Extended warranty ............................................................................................... 92
Repack the product .............................................................................................. 93
Service information form ..................................................................................... 94

Appendix C  Specifications

Physical specifications .......................................................................................... 96
Operating-environment specifications ............................................................... 96
Electrical specifications ....................................................................................... 97
Power-consumption specifications ...................................................................... 97
Acoustic emissions ............................................................................................... 98
Paper and print media specifications ................................................................... 98
1 Basics

- Product features
- Walkaround
## Product features

### Print
- Prints Letter-size and A4-size pages at speeds up to 8 pages per minute (ppm) in color and 12 ppm in black and white.
- Prints at 600 dots per inch (dpi).
- Includes adjustable settings to optimize print quality.
- The print cartridges use HP ColorSphere toner. For information about the number of pages the cartridges can print, see [www.hp.com/go/pageyield](http://www.hp.com/go/pageyield). Actual yield depends on specific use.

### Memory
- Includes 16-megabyte (MB) random-access memory (RAM)

### Supported operating systems
- Windows 2000
- Windows XP Home/Professional
- Windows Server 2003 (32-bit only)
- Windows Vista

### Paper handling
- Tray 1 holds up to 150 sheets of print media or 10 envelopes
- Output bin holds up to 125 sheets of print media

### Printer driver features
- ImageREt 2400 produces 2400-dots-per-inch (dpi) print quality for fast, high-quality printing of business text and graphics

### Interface connections
- Includes a Hi-Speed USB 2.0 port

### Environmental features
- To determine the ENERGY STAR® qualification status for this product see the Product Data Sheet or Specifications Sheet.

### Economical printing
- Provides N-up printing (printing more than one page on a sheet).
- The printer driver provides the option to manually print on both sides.

### Supplies
- Uses a print cartridge that has a no-shake design

### Accessibility
- Online user guide is compatible with text screen-readers.
- Print cartridges can be installed and removed by using one hand.
- All doors and covers can be opened by using one hand.
Walkaround

Front view

1. Output bin (holds 125 sheets of standard paper)
2. Front door (provides access to the print cartridges)
3. Jam-access door
4. Tray 1 (holds 150 sheets of standard paper)
5. Control panel

Back and side view

1. Hi-Speed USB 2.0 port
2. Rear door (for jam access)
3. Power switch
4. Power connection
Control-panel walkthrough

The product has the following lights and buttons on the control panel:

1. **Toner lights**: Indicates that a print cartridge needs to be replaced. When a print cartridge is out of the product, the corresponding light blinks.

2. **Ready light**: Indicates that the product is ready to print.

3. **Resume button and light**: Indicates that a job is paused. Press this button to continue printing the current job.

4. **Attention light**: Indicates that a door is open or other errors exist.

5. **Paper out light**: Indicates that the product is out of paper.

6. **Cancel button**: To cancel the print job that is currently printing, press the Cancel button.

7. **Jam light**: Indicates that there is a jam in the product.

**NOTE:** See Status-light patterns on page 59 for descriptions of the light patterns.
USB connection

NOTE: Do not connect the USB cable before installing the software. The installation program will notify you when the USB cable should be connected.

This product supports a USB 2.0 connection. You must use an A-to-B type USB cable for printing.

Model and serial numbers

The model number and serial number are listed on an identification label located inside the front door. The label contains information about the country/region of origin and the revision level, manufacturing date, production code, and production number of the product. The label also contains power rating and regulatory information.
2 Software

- Supported operating systems
- Printer driver
- Priority for print settings
- Open the printer driver and change the print settings
- Remove product software
- Utilities
Supported operating systems

The product supports the following operating systems:

- Windows 2000
- Windows XP Home/Professional
- Windows Server 2003 (32-bit only)
- Windows Vista

Printer driver

The product comes with software for Windows that allows the computer to communicate with the product. This software is called a printer driver. Printer drivers provide access to product features, such as printing on custom-sized paper, resizing documents, and inserting watermarks.

NOTE: The most recent drivers are available at [www.hp.com/support/ljcp1210series](http://www.hp.com/support/ljcp1210series). Depending on the configuration of Windows-based computers, the installation program for the product software automatically checks the computer for Internet access in order to obtain the latest drivers.
Priority for print settings

Changes to print settings are prioritized depending on where the changes are made:

- **Page Setup dialog box**: Click **Page Setup** or a similar command on the **File** menu of the program you are working in to open this dialog box. Settings changed here override settings changed anywhere else.

- **Print dialog box**: Click **Print**, **Print Setup**, or a similar command on the **File** menu of the program you are working in to open this dialog box. Settings changed in the **Print** dialog box have a lower priority and do **not** override changes made in the **Page Setup** dialog box.

- **Printer Properties dialog box (printer driver)**: Click **Properties** in the **Print** dialog box to open the printer driver. Settings changed in the **Printer Properties** dialog box do not override settings anywhere else in the printing software.

- **Default printer driver settings**: The default printer driver settings determine the settings used in all print jobs, *unless* settings are changed in the **Page Setup**, **Print**, or **Printer Properties** dialog boxes.
Open the printer driver and change the print settings

<table>
<thead>
<tr>
<th>Operating System</th>
<th>To change the settings for all print jobs until the software program is closed</th>
<th>To change the default settings for all print jobs</th>
<th>To change the device configuration settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 2000, XP, Server 2003, and Vista</td>
<td>1. On the <strong>File</strong> menu in the software program, click <strong>Print</strong>. 2. Select the driver, and then click <strong>Properties</strong> or <strong>Preferences</strong>. The steps can vary; this procedure is most common.</td>
<td>1. Click <strong>Start</strong>, click <strong>Settings</strong>, and then click <strong>Printers</strong> (Windows 2000) or <strong>Printers and Faxes</strong> (Windows XP Professional and Server 2003) or <strong>Printers and Other Hardware Devices</strong> (Windows XP Home). For Windows Vista, click <strong>Start</strong>, click <strong>Control Panel</strong>, and then click <strong>Printer</strong>. 2. Right-click the driver icon, and then select <strong>Printing Preferences</strong>.</td>
<td>1. Click <strong>Start</strong>, click <strong>Settings</strong>, and then click <strong>Printers</strong> (Windows 2000) or <strong>Printers and Faxes</strong> (Windows XP Professional and Server 2003) or <strong>Printers and Other Hardware Devices</strong> (Windows XP Home). For Windows Vista, click <strong>Start</strong>, click <strong>Control Panel</strong>, and then click <strong>Printer</strong>. 2. Right-click the driver icon, and then select <strong>Properties</strong>. 3. Click the <strong>Configure</strong> tab.</td>
</tr>
</tbody>
</table>

Remove product software

1. Click **Start**, and then click **All Programs**.
2. Click **HP**, and then click **HP Color LaserJet CP1210 Series**.
3. Click **Uninstall**, and then follow the onscreen instructions to remove the software.
Utilities

HP Color LaserJet CP1210 Series Toolbox software

HP Color LaserJet CP1210 Series Toolbox is a software program that you can use for the following tasks:

- Check the product status.
- Configure the product settings.
- Configure pop-up-alert messages.
- View troubleshooting information.
- View online documentation.

Status Alerts software

The Status Alerts software provides information about the current status of the product. The software also provides pop-up alerts when certain events occur, such as an empty tray or a problem with the product. The alert includes information about solving the problem.
3 Paper and print media

- Understand paper and print media use
- Supported paper and print media sizes
- Supported paper types and tray capacity
- Special paper or print media guidelines
- Load paper and print media
Understand paper and print media use

This product supports a variety of paper and other print media in accordance with the guidelines in this user guide. Paper or print media that does not meet these guidelines might cause the following problems:

- Poor print quality
- Increased jams
- Premature wear on the product, requiring repair

For best results, use only HP-brand paper and print media designed for laser printers or multiuse. Do not use paper or print media made for inkjet printers. Hewlett-Packard Company cannot recommend the use of other brands of media because HP cannot control their quality.

It is possible for paper to meet all of the guidelines in this user guide and still not produce satisfactory results. This might be the result of improper handling, unacceptable temperature and/or humidity levels, or other variables over which Hewlett-Packard has no control.

⚠️ CAUTION: Using paper or print media that does not meet Hewlett-Packard's specifications might cause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packard warranty or service agreements.
Supported paper and print media sizes

This product supports a number of paper sizes, and it adapts to various media.

**NOTE:** To obtain best print results, select the appropriate paper size and type in your print driver before printing.

### Table 3-1  Supported paper and print media sizes

<table>
<thead>
<tr>
<th>Size</th>
<th>Dimensions</th>
<th>Tray 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letter</td>
<td>216 x 279 mm (8.5 x 11 inches)</td>
<td>✔</td>
</tr>
<tr>
<td>Legal</td>
<td>216 x 356 mm (8.5 x 14 inches)</td>
<td>✔</td>
</tr>
<tr>
<td>A4</td>
<td>210 x 297 mm (8.27 x 11.69 inches)</td>
<td>✔</td>
</tr>
<tr>
<td>Executive</td>
<td>184 x 267 mm (7.24 x 10.51 inches)</td>
<td>✔</td>
</tr>
<tr>
<td>A3</td>
<td>297 x 420 mm (11.69 x 16.54 inches)</td>
<td>✔</td>
</tr>
<tr>
<td>A5</td>
<td>148 x 210 mm (5.83 x 8.27 inches)</td>
<td>✔</td>
</tr>
<tr>
<td>A6</td>
<td>105 x 148 mm (4.13 x 5.83 inches)</td>
<td>✔</td>
</tr>
<tr>
<td>B4 (JIS)</td>
<td>257 x 364 mm (10.12 x 14.33 inches)</td>
<td>✔</td>
</tr>
<tr>
<td>B5 (JIS)</td>
<td>182 x 257 mm (7.17 x 10.12 inches)</td>
<td>✔</td>
</tr>
<tr>
<td>B5 (ISO)</td>
<td>176 x 250 mm (6.93 x 9.84 inches)</td>
<td>✔</td>
</tr>
<tr>
<td>B6 (ISO)</td>
<td>125 x 176 mm (4.92 x 6.93 inches)</td>
<td>✔</td>
</tr>
<tr>
<td>16k</td>
<td>197 x 273 mm (7.75 x 10.75 inches)</td>
<td>✔</td>
</tr>
<tr>
<td>8.5 x 13</td>
<td>216 x 330 mm (8.5 x 13 inches)</td>
<td>✔</td>
</tr>
<tr>
<td>4 x 6</td>
<td>107 x 152 mm (4 x 6 inches)</td>
<td>✔</td>
</tr>
<tr>
<td>5 x 8</td>
<td>127 x 203 mm (5 x 8 inches)</td>
<td>✔</td>
</tr>
<tr>
<td>10 x 15 cm</td>
<td>100 x 150 mm (3.9 x 5.9 inches)</td>
<td>✔</td>
</tr>
<tr>
<td>Custom</td>
<td>(76 - 216) x (127 - 356) mm ((3 - 8.5) x (5 - 14) inches)</td>
<td>✔</td>
</tr>
</tbody>
</table>

### Table 3-2  Supported envelopes and postcards

<table>
<thead>
<tr>
<th>Size</th>
<th>Dimensions</th>
<th>Tray 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Envelope #10</td>
<td>105 x 241 mm (4.13 x 9.49 inches)</td>
<td>✔</td>
</tr>
<tr>
<td>Envelope DL</td>
<td>110 x 220 mm (4.33 x 8.66 inches)</td>
<td>✔</td>
</tr>
<tr>
<td>Envelope C5</td>
<td>162 x 229 mm (6.39 x 9.84 inches)</td>
<td>✔</td>
</tr>
<tr>
<td>Size</td>
<td>Dimensions</td>
<td>Tray 1</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Envelope B5</td>
<td>176 x 250 mm (6.7 x 9.8 inches)</td>
<td>✓</td>
</tr>
<tr>
<td>Envelope Monarch</td>
<td>98 x 191 mm (3.9 x 7.5 inches)</td>
<td>✓</td>
</tr>
<tr>
<td>Postcard</td>
<td>100 x 148 mm (3.94 x 5.83 inches)</td>
<td>✓</td>
</tr>
<tr>
<td>Double postcard</td>
<td>148 x 200 mm (5.83 x 7.87 inches)</td>
<td>✓</td>
</tr>
</tbody>
</table>
## Supported paper types and tray capacity

<table>
<thead>
<tr>
<th>Media type</th>
<th>Dimensions¹</th>
<th>Weight</th>
<th>Capacity²</th>
<th>Paper orientation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper, including the following types:</td>
<td>Minimum: 76 x 127 mm (3 x 5 inches)</td>
<td>60 to 90 g/m² (16 to 24 lb)</td>
<td>Up to 150 sheets</td>
<td>Side to be printed on face-up, with the top edge at the back of the tray</td>
</tr>
<tr>
<td>● Plain</td>
<td>Maximum: 216 x 356 mm (8.5 x 14 inches)</td>
<td>75 g/m² (20 lb bond)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Letterhead</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Color</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Preprinted</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Prepunched</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Recycled</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thick paper</td>
<td>Same as for paper</td>
<td>Up to 200 g/m² (53 lb)</td>
<td>Up to 15 mm (0.6 inches) stack height</td>
<td>Side to be printed on face-up, with the top edge at the back of the tray</td>
</tr>
<tr>
<td>Cover paper</td>
<td>Same as for paper</td>
<td>Up to 200 g/m² (53 lb)</td>
<td>Up to 15 mm (0.6 inches) stack height</td>
<td>Side to be printed on face-up, with the top edge at the back of the tray</td>
</tr>
<tr>
<td>Glossy paper</td>
<td>Same as for paper</td>
<td>Up to 220 g/m² (59 lb)</td>
<td>Up to 15 mm (0.6 inches) stack height</td>
<td>Side to be printed on face-up, with the top edge at the back of the tray</td>
</tr>
<tr>
<td>Transparencies</td>
<td>A4 or Letter</td>
<td>Thickness: 0.12 to 0.13 mm (4.7 to 5.1 mils)</td>
<td>Up to 50 sheets</td>
<td>Side to be printed on face-up, with the top edge at the back of the tray</td>
</tr>
<tr>
<td>Labels³</td>
<td>A4 or Letter</td>
<td>Thickness: up to 0.23 mm (9 mils)</td>
<td>Up to 50 sheets</td>
<td>Side to be printed on face-up, with the top edge at the back of the tray</td>
</tr>
<tr>
<td>Envelopes</td>
<td>● COM 10</td>
<td>Up to 90 g/m² (24 lb)</td>
<td>Up to 10 envelopes</td>
<td>Side to be printed on face-up, with the stamp-end at the back of the tray</td>
</tr>
<tr>
<td>● Monarch</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>● DL</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>● C5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>● B5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Postcards or index cards</td>
<td>100 x 148 mm (3.9 x 5.8 inches)</td>
<td>Up to 50 sheets</td>
<td></td>
<td>Side to be printed on face-up, with the top edge at the back of the tray</td>
</tr>
</tbody>
</table>

¹ The product supports a wide range of standard and custom sizes of print media. Check the printer driver for supported sizes.

² Capacity can vary depending on media weight and thickness, and environmental conditions.

³ Smoothness: 100 to 250 (Sheffield)
Special paper or print media guidelines

This product supports printing on special media. Use the following guidelines to obtain satisfactory results. When using special paper or print media, be sure to set the type and size in your print driver to obtain the best print results.

CAUTION: HP LaserJet printers use fusers to bond dry toner particles to the paper in very precise dots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper not designed for this technology could damage your printer.

<table>
<thead>
<tr>
<th>Media type</th>
<th>Do</th>
<th>Do not</th>
</tr>
</thead>
<tbody>
<tr>
<td>Envelopes</td>
<td>● Store envelopes flat.</td>
<td>● Do not use envelopes that are wrinkled, nicked, stuck together, or otherwise damaged.</td>
</tr>
<tr>
<td></td>
<td>● Use envelopes where the seam extends all the way to the corner of the envelope.</td>
<td>● Do not use envelopes that have clasps, snaps, windows, or coated linings.</td>
</tr>
<tr>
<td></td>
<td>● Use peel-off adhesive strips that are approved for use in laser printers.</td>
<td>● Do not use self-stick adhesives or other synthetic materials.</td>
</tr>
<tr>
<td>Labels</td>
<td>● Use only labels that have no exposed backing between them.</td>
<td>● Do not use labels that have wrinkles or bubbles, or are damaged.</td>
</tr>
<tr>
<td></td>
<td>● Use Labels that lie flat.</td>
<td>● Do not print partial sheets of labels.</td>
</tr>
<tr>
<td></td>
<td>● Use only full sheets of labels.</td>
<td></td>
</tr>
<tr>
<td>Transparencies</td>
<td>● Use only transparencies that are approved for use in laser printers.</td>
<td>● Do not use transparent print media not approved for laser printers.</td>
</tr>
<tr>
<td></td>
<td>● Place transparencies on a flat surface after removing them from the product.</td>
<td></td>
</tr>
<tr>
<td>Letterhead or preprinted forms</td>
<td>● Use only letterhead or forms approved for use in laser printers.</td>
<td>● Do not use raised or metallic letterhead.</td>
</tr>
<tr>
<td>Heavy paper</td>
<td>● Use only heavy paper that is approved for use in laser printers and meets the weight specifications for this product.</td>
<td>● Do not use paper that is heavier than the recommended media specification for this product unless it is HP paper that has been approved for use in this product.</td>
</tr>
<tr>
<td>Glossy or coated paper</td>
<td>● Use only glossy or coated paper that is approved for use in laser printers.</td>
<td>● Do not use glossy or coated paper designed for use in inkjet products.</td>
</tr>
</tbody>
</table>
Load paper and print media

1. Pull the tray out of the product and remove any paper.

2. Slide open the paper length and width guides.

- To load Legal-size paper, extend the tray by pressing and holding the extension tab while pulling the front of the tray toward you.

**NOTE:** When it is loaded with Legal-size paper, the tray extends from the front of the product approximately 51 mm (2 inches).
3. Place the paper in the tray and make sure that it is flat at all four corners. Slide the paper length and width guides so that they are against the stack of paper.

4. Push down on the paper to make sure that the paper stack is below the paper limit tabs on the side of the tray.

5. Slide the tray into the product.
4 Print tasks

- Change the print driver to match the media type and size
- Printer-driver Help
- Cancel a print job
- Create and use printing shortcuts in Windows
- Print booklets
- Print-quality settings
- Print on special media
- Resize documents
- Set the print orientation
- Use watermarks
- Print on both sides of the page (manual duplex)
- Print multiple pages on one sheet of paper in Windows
Change the print driver to match the media type and size

Selecting media by type and size results in significantly better print quality for heavy paper, glossy paper, and overhead transparencies. Using the wrong setting can result in unsatisfactory print quality. Always print by **Type** for special print media, such as labels or transparencies. Always print by **Size** for envelopes.

1. On the **File** menu in the software program, click **Print**.
2. Select the driver, and then click **Properties** or **Preferences**.
3. Click the **Paper/Quality** tab.
4. In the **Type is** or **Size is** list box, select the correct media type or size.
5. Click **OK**.
Printer-driver Help

Printer-driver Help is separate from program Help. The printer-driver help provides explanations for the buttons, check boxes, and drop-down lists that are in the printer driver. It also includes instructions for performing common printing tasks, such as printing on both sides, printing multiple pages on one sheet, and printing the first page or covers on different paper.

Activate the printer-driver Help screens in one of the following ways:

- In the printer driver Properties dialog box, click the Help button.
- Press the F1 key on the computer keyboard.
- Click the question-mark symbol in the upper-right corner of the printer driver.
- Right-click on any item in the driver, and then click What's This?.
Cancel a print job

You can cancel a print job from the following locations:

- **Product control panel**: To cancel the print job, press and release the Cancel button on the product control panel.

- **Software application**: Typically, a dialog box appears briefly on your screen, allowing you to cancel the print job.

- **Windows print queue**: If a print job is waiting in a print queue (computer memory) or print spooler, delete the job there.
  
  - Click Start, click Settings, and then click Printers (Windows 2000) or Printers and Faxes (Windows XP Professional and Server 2003) or Printers and Other Hardware Devices (Windows XP Home).

  - For Windows Vista, click Start, click Control Panel, and then click Printer.

  Double-click the HP Color LaserJet CP1210 Series icon to open the window, select your print job, and click Delete.

If the status lights on the control panel continue to blink after you cancel a print job, the computer is still sending the job to the printer. Either delete the job from the print queue or wait until the computer finishes sending data. The printer will return to the Ready state.
Create and use printing shortcuts in Windows

Use printing shortcuts to save the current driver settings for reuse.

Create a printing shortcut

1. On the File menu in the software program, click Print.
2. Select the driver, and then click Properties or Preferences.
3. Click the Printing Shortcuts tab.
4. Select the print settings that you want to use. Click Save As.
5. In the Printing Shortcuts box, type a name for the shortcut.
6. Click OK.

Use printing shortcuts

1. On the File menu in the software program, click Print.
2. Select the driver, and then click Properties or Preferences.
3. Click the Printing Shortcuts tab.
4. Select the shortcut that you want to use from the Printing Shortcuts box.
5. Click OK.

NOTE: To use printer-driver default settings, select Factory Default.
Print booklets

You can print booklets on letter, legal, or A4 paper.

1. Load paper in the tray.

2. On the File menu in the software program, click Print.

3. Select the driver, and then click Properties or Preferences.

4. Click the Finishing tab.

5. Select the Print On Both Sides (Manually) check box.

6. From the Booklet Layout drop-down list, Select Left Binding or Right Binding.

7. Click OK.

8. Print the document.

   The printer driver prompts you to reload the pages to print the second sides.

9. Fold and staple the pages.
Print-quality settings affect print resolution and toner usage.

1. On the **File** menu in the software program, click **Print**.

2. Select the driver, and then click **Properties** or **Preferences**.

3. On the **Paper/Quality** tab, select the print quality setting that you want to use.

   Select **Print all Text as Black** to conserve the color print cartridges. The product uses only the black print cartridge to print black text instead of using a combination of four colors to create black text.
Print on special media

Use only media that is recommended for this product. See Paper and print media on page 13 for more information.

⚠️ **CAUTION:** Be sure to set the correct media type in the printer driver. The product adjusts the fuser temperature according to the media-type setting. When printing on special media, this adjustment prevents the fuser from damaging the media as it passes through the product.

1. Load the media into the tray.
   - Load envelopes with the front side up and the stamp end toward the back of the tray.
   - Load all other paper and print media with the front side up and the top of the page toward the back of the tray.
   - When printing on both sides, load the paper with the front side down and the top of the page toward the back of the tray.

2. Adjust the media length and width guides to the size of the media.

3. On the **File** menu in the software program, click **Print**.

4. Select the driver, and then click **Properties** or **Preferences**.

5. On the **Paper/Quality** tab, choose the correct media type. Or, select an appropriate option on the **Printing Shortcuts** tab.

6. Print the document.
Resize documents

Use the document resizing options to scale a document to a percentage of its normal size. You can also choose to print a document on a different size paper, with or without scaling.

Reduce or enlarge a document

1. On the File menu in the software program, click Print.
2. Select the driver, and then click Properties or Preferences.
3. On the Effects tab, next to % of Actual Size, type the percentage by which you want to reduce or enlarge your document.
   You can also use the scroll bar to adjust the percentage.
4. Click OK.

Print a document onto a different paper size

1. On the File menu in the software program, click Print.
2. Select the driver, and then click Properties or Preferences.
4. Select the paper size to print on.
5. To print the document without scaling it to fit, make sure that the Scale to Fit option is not selected.
6. Click OK.
Set the print orientation

1. On the File menu in the software program, click Print.
2. On the Finishing tab, select either Portrait or Landscape in the Orientation section.
3. Click OK.
Use watermarks

A watermark is a notice, such as "Confidential," that is printed in the background of each page of a document.

1. On the File menu in the software program, click Print.
2. Select the driver, and then click Properties or Preferences.
3. From the Effects tab, click the Watermarks drop-down list.
4. Click the watermark that you want to use. To create a new watermark, click Edit.
5. If you want the watermark to appear only on the first page of the document, click First Page Only.
6. Click OK.

To remove the watermark, click (none) in the Watermarks drop-down list.
Print on both sides of the page (manual duplex)

To print on both sides of the paper, you must print the first side, turn the paper over and load it into the tray again, and then print the second side.

1. From the Windows desktop, click **Start**, **Settings**, and then **Printers** (or **Printers and Faxes** for some Windows versions).

2. Right-click the HP Color LaserJet CP1210 Series, and select **Properties**.

3. Click the **Configure** tab.

4. In the **Paper Handling** section, select **Allow Manual Duplexing**.

5. Click **OK**.

6. Open the **Print** dialog in the software program from which you are printing. In most programs this is done by clicking **File** and then **Print**.

7. Select the HP Color LaserJet CP1210 Series.

8. Click **Properties** or **Preferences**. The exact option name depends on the software program from which you are printing.

9. Click the **Finishing** tab.

10. Select the **Print On Both Sides (Manually)** check box.

11. Click **OK**.

12. Print side one of the document.

13. After side one has printed, remove the remaining paper from the tray and set it aside until after you finish the manual two-sided print job.

14. Gather the printed pages, and straighten the stack.

15. Return the stack to the tray with the printed side down and the top edge toward the back of the tray.

16. Press the **Resume** button to print side two.
Print multiple pages on one sheet of paper in Windows

You can print more than one page on a single sheet of paper.

1. On the File menu in the software program, click Print.
2. Select the driver, and then click Properties or Preferences.
3. Click the Finishing tab.
4. In the section for Document Options, select the number of pages that you want to print on each sheet (1, 2, 4, 6, 9, or 16).
5. If the number of pages is greater than 1, select the correct options for Print Page Borders and Page Order.
   ● If you need to change the page orientation, click Portrait or Landscape.
6. Click OK. The product is now set to print the number of pages per sheet that you have selected.
5 Color

- Manage color
- Advanced color use
- Match colors
Manage color

Setting color options to **Automatic** typically produces the best possible print quality for color documents. However, you sometimes might want to print a color document in grayscale (black and white) or change one of the printer color options.

- In Windows, use the settings on the **Color** tab in the printer driver to print in grayscale or change the color options.

Print in Grayscale

Select the **Print in Grayscale** option from the printer driver to print a color document in black and white. This option is useful for printing color documents that will be photocopied or faxed.

When **Print in Grayscale** is selected, the product uses the monochrome mode, which reduces wear on the color cartridges.

Automatic or manual color adjustment

The **Automatic** color adjustment option optimizes the neutral-gray color treatment, halftones, and edge enhancements for each element in a document. For more information, see your printer driver online Help.

| NOTE: | **Automatic** is the default setting and is recommended for printing all color documents. |

Use the **Manual** color adjustment option to adjust the neutral-gray color treatment, halftones, and edge enhancements for text, graphics, and photographs. To gain access to the manual color options, from the **Color** tab, select **Manual**, and then select **Settings**.

Manual color options

Use manual color adjustment to adjust the **Halftoning** options individually for text, graphics, and photographs.

| NOTE: | In programs that convert text or graphics to raster images, the **Photographs** settings also control text and graphics. |

<table>
<thead>
<tr>
<th>Table 5-1 Manual color options</th>
<th>Setting description</th>
<th>Setting options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Halftone</strong></td>
<td><strong>Halftone</strong> options affect the color output resolution and clarity.</td>
<td>- <strong>Smooth</strong> provides better results for large, solid-filled print areas and enhances photographs by smoothing color gradations. Select this option when uniform and smooth area fills are the top priority.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Detail</strong> is useful for text and graphics that require sharp distinctions among lines or colors, or images that contain a pattern or a high level of detail. Select this option when sharp edges and details are the top priority.</td>
</tr>
</tbody>
</table>
Neutral Grays

The Neutral Grays setting determines the method for creating gray colors used in text, graphics, and photographs.

- Black Only generates neutral colors (grays and black) by using only black toner. This guarantees neutral colors without a color cast.
- 4-Color generates neutral colors (grays and black) by combining all four toner colors. This method produces smoother gradients and transitions to other colors, and it produces the darkest black.

Edge Control

The Edge Control setting determines how edges are rendered. Edge control has two components: adaptive halftoning and trapping. Adaptive halftoning increases edge sharpness. Trapping reduces the effect of color-plane misregistration by overlapping the edges of adjacent objects slightly.

- Maximum is the most aggressive trapping setting. Adaptive halftoning is on.
- Normal. Trapping is at a medium level and adaptive halftoning is on.
- Off turns off both trapping and adaptive halftoning.

Color Themes

**Table 5-1 Manual color options (continued)**

<table>
<thead>
<tr>
<th>Setting description</th>
<th>Setting options</th>
</tr>
</thead>
<tbody>
<tr>
<td>RGB Color</td>
<td></td>
</tr>
<tr>
<td>- Default (sRGB)</td>
<td>instructs the printer to interpret RGB color as sRGB. The sRGB standard is the accepted standard of Microsoft and the World Wide Web Consortium (<a href="http://www.w3.org">http://www.w3.org</a>].</td>
</tr>
<tr>
<td>- Vivid</td>
<td>instructs the printer to increase the color saturation in the midtones. Less colorful objects are rendered more colorfully. This setting is recommended for printing business graphics.</td>
</tr>
<tr>
<td>- Photo</td>
<td>interprets RGB color as if it were printed as a photograph using a digital mini-lab. It renders deeper, more saturated colors differently than Default mode. Use this setting for printing photos.</td>
</tr>
<tr>
<td>- Photo (AdobeRGB 1998)</td>
<td>is for digital photos that use the AdobeRGB color space rather than sRGB. When printing from a professional software program that uses AdobeRGB, it is important that you turn off the color management in the software program and allow the product to manage the color space.</td>
</tr>
<tr>
<td>- None</td>
<td>sets the printer to print RGB data in raw device mode. To render photographs correctly when this option is selected, you must manage color in the program in which you are working or in the operating system.</td>
</tr>
</tbody>
</table>
Advanced color use

The product provides automatic color features that generate excellent color results. Carefully designed and tested color tables provide smooth, accurate color rendition of all printable colors.

The product also provides sophisticated tools for the experienced professional.

HP ImageREt 2400

ImageREt 2400 provides 2400 dots-per-inch (dpi) color laser-class quality through a multi-level printing process. This process precisely controls color by combining up to four colors within a single dot and by varying the amount of toner in a given area. ImageREt 2400 has been improved for this product. The improvements offer trapping technologies, greater control over dot placement, and more precise control of toner quality in a dot. These new technologies, coupled with HP's multi-level printing process, result in a 600 x 600 dpi printer that provides 2400-dpi color laser-class quality with millions of smooth colors.

In contrast, the single-level printing process found in the default mode of other color laser printers does not allow the colors to be mixed within a single dot. This process, called dithering, significantly hinders the ability to create a wide range of colors without reduced sharpness or visible dot structure.

Media selection

For the best color and image quality, select the appropriate media type from the software printer menu or from the printer driver.

Color options

Color options automatically provide optimal color output. These options use object tagging, which provides optimal color and halftone settings for different objects (text, graphics, and photos) on a page. The printer driver determines which objects appear on a page and uses halftone and color settings that provide the best print quality for each object.

In the Windows environment, the Automatic and Manual color options are on the Color tab in the printer driver.

Standard red-green-blue (sRGB)

Standard red-green-blue (sRGB) is a worldwide color standard that HP and Microsoft developed as a common color language for monitors, input devices (scanners and digital cameras), and output devices (printers and plotters). It is the default color space used for HP products, Microsoft operating systems, the World Wide Web, and most office software. The sRGB standard represents the typical Windows monitor and is the convergence standard for high-definition television.

NOTE: Factors such as the type of monitor you use and the room lighting can affect the appearance of colors on your screen. For more information, see Match colors on page 39.

The latest versions of Adobe PhotoShop®, CorelDRAW®, Microsoft Office, and many other programs use sRGB to communicate color. Because it is the default color space in Microsoft operating systems, sRGB has been adopted broadly. When programs and devices use sRGB to exchange color information, typical users experience greatly improved color matching.

The sRGB standard improves your ability to match colors between the printer, the computer monitor, and other input devices automatically, and eliminates the need to become a color expert.
**Match colors**

The process of matching printer output color to your computer screen is complex, because printers and computer monitors use different methods of producing color. Monitors *display* colors by using light pixels that use an RGB (red, green, blue) color process, but printers *print* colors by using a CMYK (cyan, magenta, yellow, and black) process.

Several factors can influence your ability to match printed colors to those on your monitor:

- Print media
- Printer colorants (inks or toners, for example)
- Printing process (inkjet, press, or laser technology, for example)
- Overhead lighting
- Personal differences in perception of color
- Software programs
- Printer drivers
- Computer operating systems
- Monitors
- Video cards and drivers
- Operating environment (humidity, for example)

Keep these factors in mind when colors on your screen do not perfectly match your printed colors.

For most users, the best method for matching colors is to print sRGB colors.

**Use the HP Color LaserJet CP1210 Series Toolbox to print the Microsoft Office Basic Colors palette**

You can use HP Color LaserJet CP1210 Series Toolbox to print a palette of the Microsoft Office Basic Colors. Use this palette to select the colors that you want to use in printed documents. It shows the actual colors that print when you select these basic colors in a Microsoft Office program.

1. In HP Color LaserJet CP1210 Series Toolbox, select the **Help** folder.
2. In the **Troubleshooting** section, select **Print Basic Colors**.
6 Manage and maintain

- Print information pages
- Use the HP Color LaserJet CP1210 Series Toolbox software
- Manage supplies
- Replace print cartridges
- Clean the product
Print information pages

Use the control panel to print configuration and supplies status pages that give details about the product and its current settings.

▲ Press and hold the Resume button for two to three seconds to print a configuration page and a supplies status page.

NOTE: Before you can print the configuration page, you must install the product software and connect the product to the computer.
Use the HP Color LaserJet CP1210 Series Toolbox software

Perform a full software installation in order to use the HP Color LaserJet CP1210 Series Toolbox.

HP Color LaserJet CP1210 Series Toolbox is a software program that you can use for the following tasks:

- Check the product status.
- Configure the product settings.
- Configure pop-up-alert messages.
- View troubleshooting information.
- View online documentation.

View HP Color LaserJet CP1210 Series Toolbox

Open HP Color LaserJet CP1210 Series Toolbox in one of these ways:

- In the Windows system tray, double-click the printer icon ().
- On the Windows Start menu, click Programs (or All Programs in Windows XP), click HP, click HP Color LaserJet CP1210 Series, and then click HP Color LaserJet CP1210 Series Toolbox.

The HP Color LaserJet CP1210 Series Toolbox software contains the following sections for each product in the Devices window:

- Status. See Status on page 44.
- Help. See Help on page 45.
- Device Settings. See Device Settings on page 46.

In addition to these sections, every page contains the following common elements:

- Shop for Supplies. See Shop for Supplies on page 49.
- Other links. See Other Links on page 49.
**Status**

The **Status** folder contains links to the following main pages:

- **Device Status.** View product status information. This page indicates product conditions such as a jam or an empty tray. After you correct a product problem, click **Refresh status** to update the product status.

- **Supplies Status.** View detailed supplies status information, such as the estimated percent of life remaining in the print cartridge and the number of pages that have been printed with the current print cartridge. This page also has links to order supplies and to find recycling information.

- **Device Configuration.** View a detailed description of the current product configuration.

- **Print Info Pages.** Print the configuration page, the demo page, and the supplies status page.

- **Event Log.** View a history of product errors. The most recent error is at the top of the list.

**Event log**

The event log is a four-column table where the product errors are logged for your reference. The number in the Page Count column specifies the total number of pages that the product had printed when the error occurred. The event log also contains a brief description of the error. For more information about error messages, see **Status-alert messages on page 63.**
The **Help** folder contains links to the following main pages:

- **Troubleshooting.** Print troubleshooting pages, clean the product, calibrate the product, and open Microsoft Office Basic Colors. For more information about Microsoft Office Basic Colors, see Match colors on page 39.

- **How do I?** Link to the user-guide index.

- **Animated demonstrations.** View animations of procedures related to using the product.

- **User Guide.** View information about product usage, warranty, specifications, and support. The user guide is available in both HTML and PDF format.

- **Readme.** View the product Readme document, which features important product notes.
Device Settings

The **Device Settings** folder contains links to the following main pages:

- **Paper Handling.** Configure the input tray or change the product paper-handling settings, such as default paper size and default paper type.

- **Print Quality.** Change the product calibration and optimization settings.

- **Print Density.** Change the print-density settings, such as contrast, highlights, midtones, and shadows.

- **Print Modes.** Change the fuser, duplex, or toner modes for each media type.

- **Paper Types.** Change the print mode settings for each media type, such as letterhead, prepunched, or glossy paper.

- **System Setup.** Change the print system settings, such as jam recovery and auto-continue. Change the **Cartridge out override** setting, which sets the option to continue printing when a print-cartridge has reached the end of its useful life.

- **Setup Status Alerts.** Set up the product so that it issues pop-up alerts to your computer when certain events occur.

- **Service.** Gain access to various procedures required to maintain the product.

- **Save/Restore Settings.** Save the product settings so you can restore them at a later date.

Paper Handling

Use the HP Color LaserJet CP1210 Series Toolbox **Paper Handling** options to configure settings for when the tray is empty.

- Select **Wait for paper to be loaded** to set the product to pause when the tray is out of media.

- Select **Specify time and action** to specify a timeout time and a paper-out action.

The **Paper out time** field specifies how long the product waits before acting on your selections. You can specify from 0 to 3600 seconds.

**NOTE:** You must click **Apply** before your changes take effect.
Print Quality

Use the HP Color LaserJet CP1210 Series Toolbox **Print Quality** options to improve the appearance of print jobs.

The following options are provided for controlling print quality:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Color Calibration| • **Power On Calibration.** Specify whether the product should calibrate when you turn it on.  
• **Calibration Timing.** Specify how frequently the product should calibrate. The default setting is 48 hours.  
• **Calibrate Now.** Click this button to calibrate immediately. |
| Optimize         | **NOTE:** HP recommends that you change these settings only if an HP customer support person advises you to.  
• **Background Toner.** Turn this setting on to reduce the occurrence of shaded background on the printed pages.  
• **Extra Cleaning.** Turn this setting on to reduce the occurrence of blurred images.  
• **Drum Banding.** Turn this setting on to reduce the occurrence of horizontal streaks on printed images.  
• **Transfer Belt Cleaning.** Turn this setting on to reduce the occurrence of vertical streaks in the background of printed images.  
• **Transfer Belt Cleaning Voltage.** Use this setting to fine-tune the voltage that is used during the cleaning process.  
• **Transfer Belt Voltage <color>.** Use this setting to fine-tune the voltage that is applied to internal components while producing the printed image. |

**NOTE:** You must click **Apply** before your changes take effect.

Print Density

Use the **Print Density** settings to make fine adjustments in the amount of each color of toner that is used for your printed documents.

- **Contrasts.** Contrast is the range of difference between light (highlight) and dark (shadow) colors. To increase the overall range between light and dark colors, increase the **Contrasts** setting.
- **Highlights.** Highlights are colors that are nearly white. To darken highlight colors, increase the **Highlights** setting. This adjustment does not affect midtone or shadow colors.
- **Midtones.** Midtones are colors that are halfway between white and solid density. To darken midtone colors, increase the **Midtones** setting. This adjustment does not affect highlight or shadow colors.
- **Shadows.** Shadows are colors that are nearly solid density. To darken shadow colors, increase the **Shadows** setting. This adjustment does not affect highlight or midtone colors.
- **Restore defaults.** Select **Restore defaults** to reset all of the density settings to the factory settings.
Print Modes

Use the Print Modes page to customize the fuser settings for specific paper types. Changing the print modes can help resolve persistent print-quality problems.

NOTE: HP recommends that you change these settings only if an HP customer support person advises you to.

Paper Types

Use the HP Color LaserJet CP1210 Series Toolbox Paper Types options to configure print modes that correspond to the various media types. When you select Restore modes, all of the modes are reset to the factory settings.

NOTE: You must click Apply before your changes take effect.

System Setup

Use the HP Color LaserJet CP1210 Series Toolbox System Settings options to configure miscellaneous product settings.

- **Jam recovery.** If this option is on, the product automatically reprints pages that are damaged when a jam occurs.

- **Auto continue.** If this setting is Off, the product waits indefinitely for you to respond to prompts that require action. If this setting is On, the product continues printing after a specific length of time, even if you have not responded to the prompt.

- **Sleep time-out.** Specify the length of time, in seconds, for the product to enter Sleep mode, after no activity has occurred.

- **Cartridge out override.** Set the option whether to continue printing after a cartridge has reached the threshold for end of life.

- **Automatic resolution reduction.** Set the option to automatically reduce the print resolution if the page requires too much memory.

- **Location.** Select the appropriate country/region.

NOTE: You must click Apply before your changes take effect.

Set up Status Alerts

Use the HP Color LaserJet CP1210 Series Toolbox to set up the product so that it issues pop-up alerts to your computer when certain events occur. Events that trigger alerts include jams, low levels of toner in HP print cartridges, non-HP print cartridge in use, empty input trays, and specific error messages.

NOTE: You must click Apply before your changes take effect.

Service

Click Restore to return the product settings to the factory default settings.
Shop for Supplies

This button, at the top of each page, links to a Web site where you can order replacement supplies. You must have Internet access to use this feature.

Other Links

This section contains links that connect you to the Internet. You must have Internet access in order to use any of these links. If you use a dial-up connection and did not connect when you first opened the HP Color LaserJet CP1210 Series Toolbox, you must connect before you can visit these Web sites. Connecting might require that you close the HP Color LaserJet CP1210 Series Toolbox and reopen it.

- **HP Instant Support**. Connects to the HP Instant Support Web site.
- **Product Support**. Connects to the support site for the product where you can search for help with a specific problem.
- **Shop for Supplies**. Order supplies at the HP Web site.
- **Product Registration**. Connects to the HP product registration Web site.
Manage supplies

Print-cartridge storage

Do not remove the print cartridge from its package until you are ready to use it.

⚠️ **CAUTION:** To prevent damage to the print cartridge, do not expose it to light for more than a few minutes.

**HP policy on non-HP print cartridges**

Hewlett-Packard Company cannot recommend the use of non-HP print cartridges, either new or remanufactured.

⚠️ **NOTE:** Any damage caused by a non-HP print cartridge is not covered under the HP warranty and service agreements.

To install a new HP print cartridge, see Replace print cartridges on page 52. To recycle the used cartridge, follow the instructions included with the new cartridge.

**HP fraud hotline and Web site**

Call the HP fraud hotline (1-877-219-3183, toll-free in North America) or go to [www.hp.com/go/anticounterfeit](http://www.hp.com/go/anticounterfeit) when you install an HP print cartridge and the control-panel message says the cartridge is non-HP. HP will help determine if the cartridge is genuine and take steps to resolve the problem.

Your print cartridge might not be a genuine HP print cartridge if you notice the following:

- You are experiencing a high number of problems with the print cartridge.
- The cartridge does not look like it usually does (for example, the orange pull tab is missing, or the packaging differs from HP packaging).
Cartridge out override

An Order Supplies message appears when a print cartridge is nearing the end of its life. A Replace Supplies message appears when the print cartridge is depleted. To ensure optimal print quality, HP recommends replacing a print cartridge when the Replace Supplies message appears. Print-quality problems can occur when using a cartridge that is depleted, resulting in waste of print media and toner from other cartridges. Replacing a print cartridge when the Replace Supplies message appears can prevent this waste.

The Cartridge out override feature in the HP Color LaserJet CP1210 Series Toolbox allows the product to continue using a print cartridge that has reached the recommended replacement point.

⚠️ WARNING! Using the Cartridge out override feature can result in unsatisfactory print quality.

⚠️ WARNING! All print defects or supply failures incurred when an HP supply is used in cartridge-out-override mode will not be considered to be defects in materials or workmanship in the supply under the HP Print Cartridge Warranty Statement. For warranty information, see Print cartridge limited warranty statement on page 89.

You can enable or disable the Cartridge out override feature at any time, and you do not have to re-enable it when you install a new print cartridge. When the Cartridge out override feature is turned on, the product automatically continues printing when a print cartridge reaches the recommended replacement level. A Replace Supplies Override In Use message appears while a print cartridge is being used in override mode. When you replace the print cartridge with a new supply, the product deactivates the override mode until another print cartridge reaches the recommended replacement level.

Enable or disable the Cartridge out override feature

2. Click the Device Settings folder, and then click the System Setup page.
3. Next to Cartridge out override select On to enable the feature. Select Off to disable it.
Replace print cartridges

1. Open the front door.

2. Pull out the print-cartridge drawer.

3. Grasp the handle on the old print cartridge and then pull the cartridge straight up to remove it.

4. Remove the new print cartridge from the packaging.
5. Remove the orange, plastic shield from the bottom of the new print cartridge.

**CAUTION:** Do not touch the imaging drum on the bottom of the print cartridge. Fingerprints on the imaging drum can cause print-quality problems.

6. Insert the new print cartridge into the product.

7. Pull the tab on the left side of the print cartridge straight up to completely remove the sealing tape. Discard the sealing tape.
8. Close the print-cartridge drawer.

9. Close the front door.

10. Place the old print cartridge in the box for the new print cartridge. Follow the recycling instructions that are included in the box.
Clean the product

During the printing process, paper, toner and dust particles can accumulate inside the product. Over time, this buildup can cause print-quality problems such as toner specks or smearing. This product has a cleaning mode that can correct and prevent these types of problems.


2. Click the Help folder, and then click the Troubleshooting page.

3. In the area for Cleaning Mode, click Start to begin the cleaning process.

4. The product processes a single page, and then returns to the ready state when the cleaning process is complete.
7 Solve problems

- Basic troubleshooting checklist
- Status-light patterns
- Status-alert messages
- Jams
- Print quality problems
- Performance problems
- Product software problems
Basic troubleshooting checklist

If you are experiencing problems with the product, use the following checklist to identify the cause of the problem:

- Is the product connected to power?
- Is the product on?
- Is the product in the **Ready** state?
- Are all necessary cables connected?
- Are genuine HP supplies installed?
- Were recently replaced print cartridges installed correctly, and was the pull tab on the cartridge removed?

For additional information about installation and setup, see the getting started guide.

If you cannot find solutions to problems in this guide, go to [www.hp.com/support/ljcp1210series](http://www.hp.com/support/ljcp1210series).

Factors that affect product performance

Several factors affect the time it takes to print a job:

- Maximum product speed, measured in pages per minute (ppm)
- The use of special paper (such as transparencies, heavy paper, and custom-size paper)
- Product processing and download time
- The complexity and size of graphics
- The speed of the computer you are using
- The USB connection
## Status-light patterns

**NOTE:** In the illustrations in the following table, the small “burst” lines around a light indicate that the light is blinking.

<table>
<thead>
<tr>
<th>Light status</th>
<th>State of the product</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Initialization/Startup/Calibration" /></td>
<td><strong>Initialization/Startup/Calibration</strong>&lt;br&gt;While in the Startup state, the Resume, Ready, and Attention lights cycle (at the rate of 500 ms) one after another.</td>
<td>During the Initialization and Job Cancel processes, pressing buttons has no effect.</td>
</tr>
<tr>
<td><img src="image" alt="Job Cancel" /></td>
<td><strong>Job Cancel</strong>&lt;br&gt;After the cancellation process has been completed, the product returns to the Ready state.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Ready" /></td>
<td><strong>Ready</strong>&lt;br&gt;The product is ready with no job activity.</td>
<td>To print a Configuration page and a Supplies Status page, press and hold the Resume button for longer than one second.</td>
</tr>
<tr>
<td><img src="image" alt="Processing Data" /></td>
<td><strong>Processing Data</strong>&lt;br&gt;The product is processing or receiving data.</td>
<td>To cancel the current job, press the Job Cancel button.</td>
</tr>
</tbody>
</table>
### Light status

<table>
<thead>
<tr>
<th>Light status</th>
<th>State of the product</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Continuable Error</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● General continuable error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Temporary product error</td>
<td>To recover from the error and print whatever data is possible, press the Resume button.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the recovery is successful, the product goes to the Processing Data state and completes the job.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the recovery is unsuccessful, the product returns to the Continuable Error state.</td>
</tr>
<tr>
<td></td>
<td><strong>Attention</strong></td>
<td>Close the door.</td>
</tr>
<tr>
<td></td>
<td>A door is open.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Fatal Error</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Turn off the product, wait 10 seconds, and turn on the product.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● If you are unable to resolve the problem, see HP Customer Care on page 90.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Yellow cartridge out or missing</strong></td>
<td>The yellow print cartridge has reached the end of life.</td>
</tr>
<tr>
<td></td>
<td>Replace the cartridge. Make sure the cartridge is installed correctly.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If you select the option to override Replace &lt;Color&gt; Cartridge, the light stops flashing and stays lit until you replace the cartridge.</td>
<td></td>
</tr>
<tr>
<td>Light status</td>
<td>State of the product</td>
<td>Action</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Magenta cartridge    | The magenta print cartridge has reached the end of life.  | Replace the cartridge. Make sure the cartridge is installed correctly.  
| out or missing       |                                                                           | **NOTE:** If you select the option to override Replace <Color> Cartridge, the light stops flashing and stays lit until you replace the cartridge. |
| Cyan cartridge       | The cyan print cartridge has reached the end of life.       | Replace the cartridge. Make sure the cartridge is installed correctly.  
| out or missing       |                                                                           | **NOTE:** If you select the option to override Replace <Color> Cartridge, the light stops flashing and stays lit until you replace the cartridge. |
| Black cartridge      | The black print cartridge has reached the end of life.      | Replace the cartridge. Make sure the cartridge is installed correctly.  
<p>| out or missing       |                                                                           | <strong>NOTE:</strong> If you select the option to override Replace &lt;Color&gt; Cartridge, the light stops flashing and stays lit until you replace the cartridge. |
| Jam                  | Clear the jam.                                               | See Jams on page 67.                                                                                                                  |</p>
<table>
<thead>
<tr>
<th>Light status</th>
<th>State of the product</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Image" /></td>
<td>Paper Out</td>
<td>Load paper or other media.</td>
</tr>
<tr>
<td><img src="image2" alt="Image" /></td>
<td>Manual Feed</td>
<td>Load acceptable paper or other media. See Paper and print media on page 13. Press the Resume button to override the condition.</td>
</tr>
</tbody>
</table>
### Status-alert messages

Status-alert messages appear on the computer screen when the product has certain problems. Use the information in the following table to solve these problems.

<table>
<thead>
<tr>
<th>Alert message</th>
<th>Description</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black Scanner Error</td>
<td>An internal error has occurred.</td>
<td>Turn off the power by using the power switch, wait at least 30 seconds, and then turn on the power and wait for the product to initialize. If you are using a surge protector, remove it. Plug the product directly into the wall socket. Use the power switch to turn on the product. If the message persists, contact HP support. See HP Customer Care on page 90.</td>
</tr>
<tr>
<td>Calibrating</td>
<td>The product is performing the internal calibration process to ensure the best possible print quality.</td>
<td>Wait for the process to complete.</td>
</tr>
<tr>
<td>Cartridge Out Override In Use</td>
<td>A print cartridge has reached the end of its useful life, but you have selected the option to override the message and continue printing. For all future print jobs, print quality could be diminished until you replace the cartridge.</td>
<td>Press the Resume button to clear the message. Replace the print cartridge as soon as possible.</td>
</tr>
<tr>
<td>Cool Down Mode</td>
<td>After prolonged, continuous operation, or after printing on narrow paper, the product must pause to cool.</td>
<td>Printing will continue when the product has cooled.</td>
</tr>
<tr>
<td>Cyan Scanner Error</td>
<td>An internal error has occurred.</td>
<td>Turn off the power by using the power switch, wait at least 30 seconds, and then turn on the power and wait for the product to initialize. If you are using a surge protector, remove it. Plug the product directly into the wall socket. Use the power switch to turn on the product. If the message persists, contact HP support. See HP Customer Care on page 90.</td>
</tr>
<tr>
<td>DC Controller Error</td>
<td>The product has experienced an internal error.</td>
<td>Turn off the power by using the power switch, wait at least 30 seconds, and then turn on the power and wait for the product to initialize. If you are using a surge protector, remove it. Plug the product directly into the wall socket. Use the power switch to turn on the product. If the message persists, contact HP support. See HP Customer Care on page 90.</td>
</tr>
<tr>
<td>Engine Communication Error</td>
<td>The product experienced an internal communication error.</td>
<td>Turn off the power by using the power switch, wait at least 30 seconds, and then turn on the power and wait for the product to initialize. If you are using a surge protector, remove it. Plug the product directly into the wall socket. Use the power switch to turn on the product.</td>
</tr>
</tbody>
</table>

ENWW

Status-alert messages 63
<table>
<thead>
<tr>
<th>Alert message</th>
<th>Description</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Front Access Door Open</td>
<td>The door is open.</td>
<td>Close the door.</td>
</tr>
<tr>
<td>Fuser Error</td>
<td>The product has experienced an error with the fuser.</td>
<td>Turn off the power by using the power switch, wait at least 30 seconds, and then turn on the power and wait for the product to initialize. If the error continues, turn off the product, wait at least 25 minutes, and then turn on the product. If you are using a surge protector, remove it. Plug the product directly into the wall socket. Use the power switch to turn on the product. If the message persists, contact HP support. See HP Customer Care on page 90.</td>
</tr>
<tr>
<td>Incorrect &lt;Color&gt; Cartridge</td>
<td>A print cartridge is installed in the incorrect slot.</td>
<td>Be sure that each print cartridge is in the correct slot. From front to back, the print cartridges are installed in this order: black, cyan, magenta, and yellow.</td>
</tr>
<tr>
<td>Install &lt;Color&gt; Cartridge</td>
<td>The cartridge is either not installed or not correctly installed in the product.</td>
<td>Install the print cartridge.</td>
</tr>
<tr>
<td>Jam in &lt;location&gt; (where the jam has occurred)</td>
<td>The product has detected a jam.</td>
<td>Clear the jam from the area indicated in the message. The job should continue to print. If it does not, try reprinting the job. See Jams on page 67. If the message persists, contact HP support. See HP Customer Care on page 90.</td>
</tr>
<tr>
<td>Load Paper &lt;Type&gt;</td>
<td>The tray is empty.</td>
<td>Load print media into the tray.</td>
</tr>
<tr>
<td>Magenta Scanner Error</td>
<td>An internal error has occurred.</td>
<td>Turn off the power by using the power switch, wait at least 30 seconds, and then turn on the power and wait for the product to initialize. If you are using a surge protector, remove it. Plug the product directly into the wall socket. Use the power switch to turn on the product. If the message persists, contact HP support. See HP Customer Care on page 90.</td>
</tr>
<tr>
<td>Manual feed</td>
<td>The product is set for manual feed mode.</td>
<td>Load the correct media into the tray, and then press the Resume button to clear the message.</td>
</tr>
<tr>
<td>Non-HP &lt;Color&gt; Cartridge</td>
<td>A new, non-HP supply has been installed. This message appears until an HP supply is installed or you press the Resume button.</td>
<td>If you believe you purchased an HP supply, go to <a href="http://www.hp.com/go/anticounterfeit">www.hp.com/go/anticounterfeit</a>. Service or repairs that are required as a result of using non-HP supplies are not covered under HP warranty. To continue printing, press the Resume button.</td>
</tr>
<tr>
<td>Alert message</td>
<td>Description</td>
<td>Recommended action</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Not Connected                              | The product software cannot communicate with the product.                    | 1. Make sure the product is turned on.  
2. Make sure the USB cable is connected securely to the product and the computer. |
<p>| Order &lt;Color&gt; Cartridge                    | The identified print cartridge is nearing the end of its useful life.        | Order the identified print cartridge. Printing will continue until Replace &lt;Color&gt; Cartridge appears.       |
| Page Too Complex                           | The product cannot process the page.                                        | Press the Resume button to continue printing the job, but output might be affected.                      |
| Printer Mispick                            | The print engine has failed to pick up a piece of media.                     | Reload the media in the input tray and press the Resume button to continue the job.                        |
|                                           |                                                                            | If the message persists, contact HP support. See HP Customer Care on page 90.                            |
| Printing                                   | The product is printing a document.                                         | Wait for printing to finish.                                                                             |
| Rear Access Door Open                      | The door is open.                                                           | Close the door.                                                                                         |
| Replace &lt;Color&gt; Cartridge                  | The print cartridge is empty.                                               | Replace the print cartridge.                                                                             |
| Replace &lt;Color&gt; Cartridge Override In Use  | A print cartridge has reached the threshold for end of life, but you have selected the option to override the message and continue printing. | Replace the print cartridge.                                                                             |
|                                           | Print-quality problems can occur.                                           |                                                                                                          |
| Replace Supplies                           | More than one print cartridge is empty.                                     | Print a supplies status page to determine which cartridges are empty. See Print information pages on page 42. |
|                                           | Replace the cartridges.                                                     |                                                                                                          |
| Replace Supplies Override In Use           | More than one print cartridge has reached the threshold for end of life, but you have selected the option to override the message and continue printing. | Replace the print cartridges.                                                                             |
|                                           | Print-quality problems can occur.                                           |                                                                                                          |
| Resolution Reduction                       | A page requires more memory than the product has available. The product has reduced the image resolution so it can print the page. | If the page requires too much memory, try simplifying it in the original software program.              |
|                                           |                                                                                             | If you do not want the product to automatically reduce the resolution, you can turn off the setting in the System Settings area of the HP Color LaserJet CP1210 Series Toolbox. See Use the HP Color LaserJet CP1210 Series Toolbox software on page 43. |
| Supply Memory Error on &lt;Color&gt;             | The e-label for one of the print cartridges cannot be read or is missing.    | Reinstall the print cartridge.                                                                           |
|                                           |                                                                                             | Turn the product off and then on.                                                                           |
|                                           |                                                                                             | If the problem is not solved, replace the cartridge.                                                        |
| Toner Dam Not Removed                      | One of the print cartridges still contains the sealing tape from shipping.     | Open the print-cartridge drawer and make sure that the sealing tape has been removed.                     |</p>
<table>
<thead>
<tr>
<th>Alert message</th>
<th>Description</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray 1 Jam</td>
<td>The product has detected a jam in the tray.</td>
<td>Clear the jam. See <a href="#">Jams on page 67</a>.</td>
</tr>
<tr>
<td>Unauthorized &lt;Color&gt; Cartridge Installed</td>
<td>A new, non-HP supply has been installed. This message appears until an HP supply is installed or you press the Resume button.</td>
<td>If you believe you purchased an HP supply, go to <a href="http://www.hp.com/go/anticounterfeit">www.hp.com/go/anticounterfeit</a>. Service or repairs that are required as a result of using non-HP supplies are not covered under HP warranty. To continue printing, press the Resume button.</td>
</tr>
<tr>
<td>Yellow Scanner Error</td>
<td>An internal error has occurred.</td>
<td>Turn off the power by using the power switch, wait at least 30 seconds, and then turn on the power and wait for the product to initialize. If you are using a surge protector, remove it. Plug the product directly into the wall socket. Use the power switch to turn on the product. If the message persists, contact HP support. See <a href="#">HP Customer Care on page 90</a>.</td>
</tr>
</tbody>
</table>
Jams

Use this illustration to find the locations of jams. For instructions to clear jams, see Clear jams on page 69.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Output bin</td>
</tr>
<tr>
<td>2</td>
<td>Tray 1</td>
</tr>
<tr>
<td>3</td>
<td>Fuser</td>
</tr>
</tbody>
</table>

Jam recovery

When the Jam Recovery feature is turned on, the product reprints any pages that are damaged during a jam.


2. Click the Device Settings folder, and then click System Setup.

3. Next to Jam Recovery, select On from the drop-down list.
# Common causes of jams

<table>
<thead>
<tr>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The paper length and width guides are not adjusted correctly.</td>
<td>Adjust the guides so they are against the paper stack.</td>
</tr>
<tr>
<td>The media does not meet specifications.</td>
<td>Use only media that meets HP specifications. See <a href="#">Paper and print media on page 13</a>.</td>
</tr>
<tr>
<td>You are using media that has already passed through a printer or copier.</td>
<td>Do not use media that has been previously printed on or copied.</td>
</tr>
<tr>
<td>An input tray is loaded incorrectly.</td>
<td>Remove any excess media from the input tray. Make sure that the stack is below the maximum stack height mark in the tray. See <a href="#">Load paper and print media on page 19</a>.</td>
</tr>
<tr>
<td>The media is skewed.</td>
<td>The input-tray guides are not adjusted correctly. Adjust them so they hold the stack firmly in place without bending it.</td>
</tr>
<tr>
<td>The media is binding or sticking together.</td>
<td>Remove the media, flex it, rotate it 180 degrees, or flip it over. Reload the media into the input tray.</td>
</tr>
<tr>
<td>The media is removed before it settles into the output bin.</td>
<td>Wait until the page completely settles in the output bin before removing it.</td>
</tr>
<tr>
<td>The media is in poor condition.</td>
<td>Replace the media.</td>
</tr>
<tr>
<td>The internal rollers from the tray are not picking up the media.</td>
<td>Remove the top sheet of media. If the media is heavier than 163 g/m² (43 lb), it might not be picked from the tray.</td>
</tr>
<tr>
<td>The media has rough or jagged edges.</td>
<td>Replace the media.</td>
</tr>
<tr>
<td>The media is perforated or embossed.</td>
<td>Perforated or embossed media does not separate easily. Load sheets one at a time.</td>
</tr>
<tr>
<td>Paper was not stored correctly.</td>
<td>Replace the paper in the trays. Paper should be stored in the original packaging in a controlled environment.</td>
</tr>
</tbody>
</table>

1 If the product continues to jam, contact HP Customer Support or your authorized HP service provider.
Clear jams

Jam in tray 1

1. Pull out tray 1 and place it on a flat surface.

2. Remove the jammed sheet by pulling it straight out.

3. Replace tray 1.

4. Press the Resume button to continue printing.
Jam in fuser area

1. Open the rear door.

2. Remove any jammed sheets.

   **NOTE:** If the sheet tears, make sure that all fragments are removed before you resume printing.

3. Close the rear door.
Jam in output bin

1. Look for jammed paper in the output bin area.

2. Remove any visible media.

   **NOTE:** If the sheet tears, make sure that all fragments are removed before resuming printing.

3. Open and then close the rear door to clear the message.
Print quality problems

Occasionally, you might encounter problems with print quality. The information in the following sections helps you identify and resolve these issues.

Improve print quality

Always make sure that the **Type is** setting in the printer driver matches the type of paper that you are using.

Use the print-quality settings in the printer driver to prevent print-quality problems. See [Print-quality settings on page 27](#).

Use the **Device Settings** area in the HP Color LaserJet CP1210 Series Toolbox to adjust settings that affect print quality. See [Use the HP Color LaserJet CP1210 Series Toolbox software on page 43](#). Also use the HP Color LaserJet CP1210 Series Toolbox to help troubleshoot print-quality problems. See [Use the HP Color LaserJet CP1210 Series Toolbox to troubleshoot print-quality problems on page 79](#).

Identify and correct print defects

Use the checklist and print-quality issues charts in this section to solve print-quality problems.

Print-quality checklist

General print-quality problems can be solved by using the following checklist:

1. Make sure that the paper or print media that you are using meets specifications. Generally, smoother paper provides better results.

2. If you are using a special print media such as labels, transparencies, glossy, or letterhead, ensure that you have printed by type.

3. Print a Configuration page and Supplies Status page. See [Print information pages on page 42](#).
   - Check the Supplies Status page to see if any supplies are low or empty. No information is provided for non-HP print cartridges.
   - If the pages do not print correctly, the problem is with the hardware. Contact HP Customer Care. See [HP Customer Care on page 90](#) or the flyer that came in the box.

4. Print a Demo page from the HP Color LaserJet CP1210 Series Toolbox. If the page prints, the problem is with the printer driver.

5. Try printing from a different program. If the page prints correctly, the problem is with the program from which you were printing.

6. Restart the computer and the product and try printing again. If the problem is not resolved, choose one of these options:
   - If the problem is affecting all printed pages, see [General print quality issues on page 73](#).
   - If the problem is affecting only pages printed in color, see [Solve issues with color documents on page 77](#).
The following examples depict Letter-size paper that has passed through the product short-edge first. These examples illustrate problems that would affect all of the pages that you print, whether you print in color or in black only. The topics that follow list the typical cause and solution for each of these examples.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print is light or faded.</td>
<td>The media might not meet HP specifications.</td>
<td>Use media that meets HP specifications.</td>
</tr>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>One or more print cartridges might be defective.</td>
<td>Print the Supplies Status page to check the remaining life. See Print information pages on page 42.</td>
</tr>
<tr>
<td></td>
<td>The product is set to override the Replace &lt;Color&gt; Cartridge message and to continue printing.</td>
<td>Replace any low print cartridges. See Replace print cartridges on page 52.</td>
</tr>
<tr>
<td>Toner specks appear.</td>
<td>The media might not meet HP specifications.</td>
<td>Use media that meets HP specifications.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /></td>
<td>The paper path might need cleaning.</td>
<td>Clean the paper path. See Clean the product on page 55.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>The moisture content of the paper is uneven or the paper has moist spots on its surface.</td>
<td>Try different paper, such as high-quality paper that is intended for color laser printers.</td>
</tr>
<tr>
<td></td>
<td>The paper lot is flawed. The manufacturing processes can cause some areas to reject toner.</td>
<td>Try different paper, such as high-quality paper that is intended for color laser printers.</td>
</tr>
<tr>
<td>Vertical streaks or bands appear on the page.</td>
<td>One or more print cartridges might be defective.</td>
<td>Print the Supplies Status page to check the remaining life. See Print information pages on page 42.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Image" /></td>
<td>The product is set to override the Replace &lt;Color&gt; Cartridge message and to continue printing.</td>
<td>Replace any low print cartridges. See Replace print cartridges on page 52.</td>
</tr>
<tr>
<td>Problem</td>
<td>Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The amount of background toner shading becomes unacceptable.</td>
<td>Very dry (low humidity) conditions can increase the amount of background shading.</td>
<td>Check the device environment.</td>
</tr>
<tr>
<td></td>
<td>One or more print cartridges might be defective.</td>
<td>Replace any low print cartridges. See Replace print cartridges on page 52.</td>
</tr>
<tr>
<td></td>
<td>The product is set to override the Replace &lt;Color&gt; Cartridge message and to continue printing.</td>
<td>Replace any low print cartridges. See Replace print cartridges on page 52.</td>
</tr>
<tr>
<td>Toner smears appear on the media.</td>
<td>The media might not meet HP specifications.</td>
<td>Use media that meets HP specifications.</td>
</tr>
<tr>
<td></td>
<td>If toner smears appear on the leading edge of the paper, the media guides are dirty, or debris has accumulated in the print path.</td>
<td>Clean the media guides. Clean the paper path. See Clean the product on page 55.</td>
</tr>
<tr>
<td>The toner smears easily when touched.</td>
<td>The device is not set to print on the type of media on which you want to print.</td>
<td>In the printer driver, select the Paper tab and set Type is to match the type of media on which you are printing. Print speed might be slower if you are using heavy paper.</td>
</tr>
<tr>
<td></td>
<td>The media might not meet HP specifications.</td>
<td>Use media that meets HP specifications.</td>
</tr>
<tr>
<td></td>
<td>The paper path might need cleaning.</td>
<td>Clean the paper path. See Clean the product on page 55.</td>
</tr>
<tr>
<td>Problem</td>
<td>Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
<td>----------</td>
</tr>
<tr>
<td>Marks repeatedly appear at even intervals on the printed side of the page.</td>
<td>The device is not set to print on the type of media on which you want to print.</td>
<td>In the printer driver, select the <strong>Paper</strong> tab and set <strong>Type is</strong> to match the type of paper on which you are printing. Print speed might be slower if you are using heavy paper.</td>
</tr>
<tr>
<td></td>
<td>Internal parts might have toner on them.</td>
<td>The problem typically corrects itself after a few more pages.</td>
</tr>
<tr>
<td></td>
<td>The paper path might need cleaning.</td>
<td>Clean the paper path. See <a href="#">Clean the product on page 55</a>.</td>
</tr>
<tr>
<td></td>
<td>The fuser might be damaged or dirty.</td>
<td>To determine if the fuser has a problem, open the HP Color LaserJet CP1210 Series Toolbox and print the print-quality diagnostics page. See <a href="#">Use the HP Color LaserJet CP1210 Series Toolbox software on page 43</a>. Contact HP Customer Care. See <a href="#">HP Customer Care on page 90</a> or the support flyer that came in the box.</td>
</tr>
<tr>
<td></td>
<td>A print cartridge may have a problem.</td>
<td>To determine which cartridge has a problem, open the HP Color LaserJet CP1210 Series Toolbox and print the print-quality diagnostics page. See <a href="#">Use the HP Color LaserJet CP1210 Series Toolbox software on page 43</a>. Contact HP Customer Care. See <a href="#">HP Customer Care on page 90</a> or the support flyer that came in the box.</td>
</tr>
<tr>
<td>Marks repeatedly appear at even intervals on the unprinted side of the page.</td>
<td>Internal parts might have toner on them.</td>
<td>The problem typically corrects itself after a few more pages.</td>
</tr>
<tr>
<td></td>
<td>The paper path might need cleaning.</td>
<td>Clean the paper path. See <a href="#">Clean the product on page 55</a>.</td>
</tr>
<tr>
<td></td>
<td>The fuser might be damaged or dirty.</td>
<td>To determine if the fuser has a problem, open the HP Color LaserJet CP1210 Series Toolbox and print the print-quality diagnostics page. See <a href="#">Use the HP Color LaserJet CP1210 Series Toolbox software on page 43</a>. Contact HP Customer Care. See <a href="#">HP Customer Care on page 90</a> or the support flyer that came in the box.</td>
</tr>
<tr>
<td>The printed page contains misformed characters.</td>
<td>The media might not meet HP specifications.</td>
<td>Use a different paper, such as high-quality paper that is intended for color laser printers.</td>
</tr>
<tr>
<td></td>
<td>If characters are incorrectly formed so that they produce a wavy effect, the laser scanner might need service.</td>
<td>Verify that the problem also occurs on the Configuration page. If so, contact HP Customer Care. See <a href="#">HP Customer Care on page 90</a> or the support flyer that came in the box.</td>
</tr>
<tr>
<td>Problem</td>
<td>Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The printed page is curled or wavy.</td>
<td>The device is not set to print on the type of media on which you want to print.</td>
<td>In the printer driver, select the <strong>Paper</strong> tab and set <strong>Type</strong> to match the type of paper on which you are printing. Print speed might be slower if you are using heavy paper.</td>
</tr>
<tr>
<td></td>
<td>The media might not meet HP specifications.</td>
<td>Use a different paper, such as high-quality paper that is intended for color laser printers.</td>
</tr>
<tr>
<td></td>
<td>Both high temperature and humidity can cause paper curl.</td>
<td>Check the device environment.</td>
</tr>
<tr>
<td>Text or graphics are skewed on the printed page.</td>
<td>The media might be loaded incorrectly.</td>
<td>Make sure that the paper or other print media is loaded correctly and that the media guides are not too tight or too loose against the stack. See <strong>Load paper and print media</strong> on page 19.</td>
</tr>
<tr>
<td></td>
<td>The media might not meet HP specifications.</td>
<td>Use a different paper, such as high-quality paper that is intended for color laser printers.</td>
</tr>
<tr>
<td>The printed page contains wrinkles or creases.</td>
<td>The media might be loaded incorrectly.</td>
<td>Verify that the media is loaded correctly and that the media guides are not too tight or too loose against the stack. See <strong>Load paper and print media</strong> on page 19.</td>
</tr>
<tr>
<td></td>
<td>The media might not meet HP specifications.</td>
<td>Use a different paper, such as high-quality paper that is intended for color laser printers.</td>
</tr>
<tr>
<td></td>
<td>Turn over the stack of paper in the input tray.</td>
<td>Turn over the stack of paper in the input tray.</td>
</tr>
<tr>
<td>Toner appears around the printed characters.</td>
<td>The media might be loaded incorrectly.</td>
<td>Turn over the stack of paper in the tray.</td>
</tr>
<tr>
<td></td>
<td>If large amounts of toner have scattered around the characters, the paper might have high resistivity.</td>
<td>Use a different paper, such as high-quality paper that is intended for color laser printers.</td>
</tr>
</tbody>
</table>
An image that appears at the top of the page (in solid black) repeats farther down the page (in a gray field).

Software settings might affect image printing.

In your software program, change the tone (darkness) of the field in which the repeated image appears.

In your software program, rotate the whole page 180° to print the lighter image first.

The order of images printed might affect printing.

Change the order in which the images are printed. For example, have the lighter image at the top of the page, and the darker image farther down the page.

A power surge might have affected the device.

If the defect occurs later in a print job, turn the device off for 10 minutes, and then turn on the device to restart the print job.

---

**Solve issues with color documents**

This section describes issues that can occur when you print in color.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only black is printing when the document should be printing in color.</td>
<td>Color mode is not selected in your program or printer driver.</td>
<td>Select color mode instead of grayscale mode.</td>
</tr>
<tr>
<td></td>
<td>The correct printer driver might not be selected in the program.</td>
<td>Select the correct printer driver.</td>
</tr>
<tr>
<td></td>
<td>The device might not be correctly configured.</td>
<td>Print a Configuration page. If no color appears on the Configuration page, contact HP Customer Care. See HP Customer Care on page 90 or the support flyer that came in the box.</td>
</tr>
<tr>
<td>One or more colors are not printing, or are inaccurate.</td>
<td>Sealing tape might be on the print cartridges.</td>
<td>Verify that the sealing tape has been completely removed from the print cartridges.</td>
</tr>
<tr>
<td></td>
<td>The media might not meet HP specifications.</td>
<td>Use a different paper, such as high-quality paper that is intended for color laser printers.</td>
</tr>
<tr>
<td></td>
<td>The device might be operating in excessively humid conditions.</td>
<td>Verify that the device environment is within humidity specifications.</td>
</tr>
<tr>
<td></td>
<td>One or more print cartridges might be defective.</td>
<td>Replace any low print cartridges. See Replace print cartridges on page 52.</td>
</tr>
<tr>
<td></td>
<td>The product is set to override the Replace &lt;Color&gt; Cartridge message and to continue printing.</td>
<td>Replace any low print cartridges. See Replace print cartridges on page 52.</td>
</tr>
<tr>
<td>Problem</td>
<td>Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>A color is printing inconsistently after you load a new print cartridge.</td>
<td>Another print cartridge might be defective.</td>
<td>Remove the print cartridge for the color that is printing inconsistently and reinstall it.</td>
</tr>
<tr>
<td>The colors on the printed page do not match the colors as they appear on the screen.</td>
<td>The colors on your computer monitor might differ from the device output.</td>
<td>See <a href="#">Match colors on page 39</a></td>
</tr>
<tr>
<td>The finish on the printed color page is inconsistent.</td>
<td>The media might not meet HP specifications.</td>
<td>Use a different paper, such as high-quality paper that is intended for color laser printers.</td>
</tr>
</tbody>
</table>
Use the HP Color LaserJet CP1210 Series Toolbox to troubleshoot print-quality problems

From the HP Color LaserJet CP1210 Series Toolbox software you can print a page that helps identify which print cartridge is causing the problem. The print-quality troubleshooting page prints five bands of color, which are divided into four overlapping sections. By examining each section, you can isolate the problem to a particular cartridge.

<table>
<thead>
<tr>
<th>Section</th>
<th>Print-cartridge</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Yellow</td>
</tr>
<tr>
<td>2</td>
<td>Cyan</td>
</tr>
<tr>
<td>3</td>
<td>Black</td>
</tr>
<tr>
<td>4</td>
<td>Magenta</td>
</tr>
</tbody>
</table>

- If a mark or spot appears in only one section, replace the print cartridge that corresponds to that section.
- If a mark or line appears in more than one section, replace the print cartridge that matches the color of the mark or line.
- If a repeating pattern of dots, marks, or lines appears on the page, clean the product. See Clean the product on page 55. After cleaning the product, print another print-quality troubleshooting page to see if the defect is gone.

Print the print-quality troubleshooting page

2. Click the Help folder, and then click the Troubleshooting page.
3. Click the Print button, and then follow the directions on the printed pages.

Calibrate the product

If you experience any print-quality problems, calibrate the product.

2. Click the Device Settings folder, and then click the Print Quality page.
3. In the area for Color Calibration, click Calibrate to calibrate the product immediately.
## Performance problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pages print but are totally blank.</td>
<td></td>
<td>The sealing tape might still be in the print cartridges. Verify that the sealing tape has been completely removed from the print cartridges.</td>
</tr>
<tr>
<td></td>
<td>The document might contain blank pages.</td>
<td>Check the document that you are printing to see if content appears on all of the pages.</td>
</tr>
<tr>
<td></td>
<td>The product might be malfunctioning.</td>
<td>To check the product, print a Configuration page.</td>
</tr>
<tr>
<td>Pages print very slowly.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Heavier media types can slow the print job.</td>
<td>Print on a different type of media.</td>
</tr>
<tr>
<td></td>
<td>Complex pages can print slowly.</td>
<td>Proper fusing may require a slower print speed to ensure the best print quality.</td>
</tr>
<tr>
<td>Pages did not print.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The product might not be pulling media correctly.</td>
<td>Make sure paper is loaded in the tray correctly. If the problem persists, you might need to replace the pickup rollers and the separation pad. See HP Customer Care on page 90.</td>
</tr>
<tr>
<td>The media is jamming in the device.</td>
<td></td>
<td>Clear the jam. See Jams on page 67.</td>
</tr>
<tr>
<td>Other devices are running on your computer.</td>
<td></td>
<td>The product might not share a USB port. If you have an external hard drive or network switchbox that is connected to the same port as the product, the other device might be interfering. To connect and use the product, you must disconnect the other device or you must use two USB ports on the computer.</td>
</tr>
</tbody>
</table>

80 Chapter 7   Solve problems ENWW
## Product software problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
</table>
| A printer driver for the product is not visible in the **Printer** folder | ● Reinstall the product software.  
**NOTE:** Close any applications that are running. To close an application that has an icon in the system tray, right-click the icon, and select **Close** or **Disable**.  
● Try plugging the USB cable into a different USB port on the computer. |
| An error message was displayed during the software installation         | ● Reinstall the product software.  
**NOTE:** Close any applications that are running. To close an application that has an icon in the task bar, right-click the icon, and select **Close** or **Disable**.  
● Check the amount of free space on the drive where you are installing the product software. If necessary, free up as much space as you can, and reinstall the product software.  
● If necessary, run the Disk Defragmenter, and reinstall the product software. |
| The product is in Ready mode, but nothing prints                       | ● Print a Configuration page, and verify the product functionality.  
● Verify that all of the cables are correctly seated and within specifications. This includes the USB and power cables. Try a new cable. |
Supplies and accessories

- To order supplies in the U.S., go to www.hp.com/sbso/product/supplies.
- To order supplies worldwide, go to www.hp.com/ghp/buyonline.html.
- To order supplies in Canada, go to www.hp.ca/catalog/supplies.
- To order supplies in Europe, go to www.hp.com/go/ljsupplies.
- To order supplies in Asia-Pacific, go to www.hp.com/paper/.
- To order accessories, go to www.hp.com/go/accessories.
Order parts, accessories, and supplies

Several methods are available for ordering parts, supplies, and accessories.

Order directly from HP

You can obtain the following items directly from HP:

- **Replacement parts**: To order replacement parts in the U.S., go to [www.hp.com/go/hpparts](http://www.hp.com/go/hpparts). Outside the United States, order parts by contacting your local authorized HP service center.


Order through service or support providers

To order a part or accessory, contact an HP-authorized service or support provider.

Order directly through the HP Color LaserJet CP1210 Series Toolbox software

HP Color LaserJet CP1210 Series Toolbox software is a printer management tool designed to make printer configuration, monitoring, supplies ordering, troubleshooting, and updating as simple and efficient as possible. For more information about HP Color LaserJet CP1210 Series Toolbox software, see Use the HP Color LaserJet CP1210 Series Toolbox software on page 43.
### Table A-1  Spare parts and replacement supplies

<table>
<thead>
<tr>
<th>Part</th>
<th>Part number</th>
<th>Type/size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print cartridges</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Black print cartridge</td>
<td>CB540A</td>
<td>Black print cartridge</td>
</tr>
<tr>
<td>Cyan print cartridge</td>
<td>CB541A</td>
<td>Cyan print cartridge</td>
</tr>
<tr>
<td>Yellow print cartridge</td>
<td>CB542A</td>
<td>Yellow print cartridge</td>
</tr>
<tr>
<td>Magenta print cartridge</td>
<td>CB543A</td>
<td>Magenta print cartridge</td>
</tr>
<tr>
<td>Cables</td>
<td>C6518A</td>
<td>USB 2.0 printer cable (2-meter [6.5-foot] standard)</td>
</tr>
<tr>
<td>Part</td>
<td>Part number</td>
<td>Type/size</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Media</td>
<td>C2934A</td>
<td>50 sheets HP Color LaserJet Transparencies (letter)</td>
</tr>
<tr>
<td></td>
<td>C2936A</td>
<td>50 sheets HP Color Laser Transparencies (A4)</td>
</tr>
<tr>
<td></td>
<td>Q1298A</td>
<td>HP LaserJet Tough paper (letter)</td>
</tr>
<tr>
<td></td>
<td>Q1298B</td>
<td>HP LaserJet Tough paper (A4)</td>
</tr>
<tr>
<td></td>
<td>HPU1132</td>
<td>500 sheets HP Premium Choice LaserJet paper (letter)</td>
</tr>
<tr>
<td></td>
<td>CHP410</td>
<td>500 sheets HP Premium Choice LaserJet paper (A4)</td>
</tr>
<tr>
<td></td>
<td>HPJ1124</td>
<td>500 sheets HP LaserJet paper (letter)</td>
</tr>
<tr>
<td></td>
<td>CHP310</td>
<td>500 sheets HP LaserJet paper (A4)</td>
</tr>
<tr>
<td></td>
<td>Q6608A</td>
<td>100 sheets HP Color Laser Photo Paper, glossy</td>
</tr>
<tr>
<td></td>
<td>Q6611A</td>
<td>150 sheets HP Color Laser Brochure Paper, glossy (letter)</td>
</tr>
<tr>
<td></td>
<td>Q6541A</td>
<td>200 sheets HP Presentation Laser Paper, soft gloss (letter)</td>
</tr>
<tr>
<td></td>
<td>Q6543A</td>
<td>150 sheets HP Presentation Laser Paper, glossy</td>
</tr>
<tr>
<td></td>
<td>Q2546A</td>
<td>300 sheets HP Brochure Laser Paper, matte (letter)</td>
</tr>
<tr>
<td></td>
<td>Q6549A</td>
<td>100 sheets HP Brochure Laser Paper, matte (letter)</td>
</tr>
<tr>
<td></td>
<td>HPL285R</td>
<td>500 sheets HP Color Laser Paper (letter)</td>
</tr>
</tbody>
</table>

Reference materials 5851-1468  
*HP LaserJet Printer Family Print Media Specification Guide*
B Service and support
Hewlett-Packard limited warranty statement

HP Color LaserJet CP1215/CP1515/CP1518 Series printers

One-year limited warranty

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from defects in materials and workmanship after the date of purchase, for the period specified above. If HP receives notice of such defects during the warranty period, HP will, at its option, either repair or replace products which prove to be defective. Replacement products may be either new or equivalent in performance to new.

HP warrants to you that HP software will not fail to execute its programming instructions after the date of purchase, for the period specified above, due to defects in material and workmanship when properly installed and used. If HP receives notice of such defects during the warranty period, HP will replace software which does not execute its programming instructions due to such defects.

HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is unable, within a reasonable time, to repair or replace any product to a condition as warranted, you will be entitled to a refund of the purchase price upon prompt return of the product.

HP products may contain remanufactured parts equivalent to new in performance or may have been subject to incidental use.

Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or calibration, (b) software, interfacing, parts or supplies not supplied by HP, (c) unauthorized modification or misuse, (d) operation outside of the published environmental specifications for the product, or (e) improper site preparation or maintenance.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND NO OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE. Some countries/regions, states or provinces do not allow limitations on the duration of an implied warranty, so the above limitation or exclusion might not apply to you. This warranty gives you specific legal rights and you might also have other rights that vary from country/region to country/region, state to state, or province to province. HP’s limited warranty is valid in any country/region or locality where HP has a support presence for this product and where HP has marketed this product. The level of warranty service you receive may vary according to local standards. HP will not alter form, fit or function of the product to make it operate in a country/region for which it was never intended to function for legal or regulatory reasons.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT ARE YOUR SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE. Some countries/regions, states or provinces do not allow the exclusion or limitation of incidental or consequential damages, so the above limitation or exclusion may not apply to you.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
Print cartridge limited warranty statement

This HP product is warranted to be free from defects in materials and workmanship.

This warranty does not apply to products that (a) have been refilled, refurbished, remanufactured or tampered with in any way, (b) experience problems resulting from misuse, improper storage, or operation outside of the published environmental specifications for the printer product or (c) exhibit wear from ordinary use.

To obtain warranty service, please return the product to place of purchase (with a written description of the problem and print samples) or contact HP customer support. At HP’s option, HP will either replace products that prove to be defective or refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
HP Customer Care

Online Services

For 24-hour access to updated HP device-specific software, product information, and support information through an Internet connection, go to the Web site: www.hp.com/support/ljcp1210series.


Telephone support

HP provides free telephone support during the warranty period. For the telephone number for your country/region, see the flyer that shipped with the device, or visit www.hp.com/support/. Before calling HP, have the following information ready: the product name and serial number, the date of purchase, and a description of the problem.

Software utilities, drivers, and electronic information

www.hp.com/go/ljcp1210series_software

The Web page for the drivers is in English, but you can download the drivers themselves in several languages.

HP direct ordering for accessories or supplies

- Canada: www.hp.ca/catalog/supplies
- Europe: www.hp.com/ljsupplies
- Asia-Pacific: www.hp.com/paper/

To order genuine HP parts or accessories, go to the HP Parts Store at www.hp.com/buy/parts (U.S. and Canada only), or call 1-800-538-8787 (U.S.) or 1-800-387-3154 (Canada).

HP service information

To locate HP-Authorized Dealers, call 1-800-243-9816 (U.S.) or 1-800-387-3867 (Canada).

Outside the United States and Canada, call the customer support number for your country/region. See the flyer that shipped in the box with the device.

HP service agreements

Call 1-800-HPINVENT (1-800-474-6836 (U.S.)) or 1-800-268-1221 (Canada). Or, go to the HP Care Pack Services Web site at www.hpexpress-services.com/10467a.

For extended service, call 1-800-446-0522.

HP Color LaserJet CP1210 Series Toolbox

To check the device status and settings and view troubleshooting information and online documentation, use the HP Color LaserJet CP1210 Series Toolbox. You must have performed a full software installation.
in order to use the HP Color LaserJet CP1210 Series Toolbox. See Use the HP Color LaserJet CP1210 Series Toolbox software on page 43.
HP maintenance agreements

HP has several types of maintenance agreements that meet a wide range of support needs. Maintenance agreements are not part of the standard warranty. Support services may vary by area. Check with your local HP dealer to determine the services available to you.

HP Care Pack™ Services and Service Agreements

HP has various service and support options that meet a wide range of needs. These options are not part of the standard warranty. Support services may vary by location. For most printers HP offers both in-warranty and post-warranty HP Care Pack Services and Service Agreements.

To identify service and support options for this printer go to [http://www.hpexpress-services.com/10467a](http://www.hpexpress-services.com/10467a) and type the printer model number. In North America, Service Agreement information can be obtained through HP Customer Care. Call 1-800-HPINVENT 1-800-474-6836 (U.S.) or 1-800-268-1221 (Canada). In other countries/regions please contact your country/region specific HP Customer Care Center. See the inbox flyer or go to [http://www.hp.com](http://www.hp.com) for the HP Customer Care telephone number in your country/region.

Extended warranty

HP Support provides coverage for the HP hardware product and all HP-supplied internal components. The hardware maintenance covers a 1- to 3-year period from date of the HP product purchase. The customer must purchase HP Support within the stated factory warranty. For more information, contact the HP Customer Care Service and Support group.
Repack the product

If your product needs to be moved or shipped to another location, perform the following procedure to repack it.

⚠️ **CAUTION:** Shipping damage as a result of inadequate packing is the customer’s responsibility. The product must remain upright during shipment.

To repack the product

⚠️ **CAUTION:** It is extremely important to remove the print cartridges before shipping the product. Print cartridges left in the printer during shipping will leak and entirely cover the product with toner.

To prevent damage to the print cartridges, avoid touching the rollers, and store them in the original packing material or so that they are not exposed to light.

1. Remove all four print cartridges and ship separately.

2. Use the original shipping container and packing material, if possible. If you have already disposed of the packing material, contact a local mailing service for information about repacking the printer. HP recommends insuring the equipment for shipment.
Service information form

WHO IS RETURNING THE EQUIPMENT?

Date:

Person to contact: Phone:

Alternate contact: Phone:

Return shipping address: Special shipping instructions:

WHAT ARE YOU SENDING?

Model name: Model number: Serial number:

Please attach any relevant printouts. Do NOT ship accessories (manuals, cleaning supplies, and so on) that are not required to complete the repair.

HAVE YOU REMOVED THE PRINT CARTRIDGES?

[ ] Yes. [ ] No, I cannot remove them.

WHAT NEEDS TO BE DONE? (Attach a separate sheet if necessary.)

1. Describe the conditions of the failure. (What was the failure? What were you doing when the failure occurred? What software were you running? Is the failure repeatable?)

2. If the failure is intermittent, how much time elapses between failures?

3. If the unit connected to any of the following, give the manufacturer and model number.

   Personal computer: Modem: Network:

4. Additional comments:

HOW WILL YOU PAY FOR THE REPAIR?

[ ] Under warranty Purchase/received date:

   (Attach proof of purchase or receiving document with original received date.)

   [ ] Maintenance contract number:

   [ ] Purchase order number:

   Except for contract and warranty service, a purchase order number and/or authorized signature must accompany any request for service. If standard repair prices do not apply, a minimum purchase order is required. Standard repair prices can be obtained by contacting an HP-authorized repair center.

Authorized signature: Phone:

Billing address: Special billing instructions:
C Specifications

- Physical specifications
- Operating-environment specifications
- Electrical specifications
- Power-consumption specifications
- Acoustic emissions
- Paper and print media specifications
- Skew specifications
### Physical specifications

<table>
<thead>
<tr>
<th></th>
<th>Height</th>
<th>Depth</th>
<th>Width</th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>254 mm (10.0 inches)</td>
<td>436 mm (17.2 inches)</td>
<td>399 mm (15.7 inches)</td>
<td>18.20 kg (40.02 lb)</td>
</tr>
</tbody>
</table>

### Operating-environment specifications

<table>
<thead>
<tr>
<th>Environment</th>
<th>Recommended</th>
<th>Allowed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>17° to 25°C (62.6° to 77°F)</td>
<td>15° to 30°C (59° to 86°F)</td>
</tr>
<tr>
<td>Humidity</td>
<td>20% to 60% relative humidity (RH)</td>
<td>10% to 80% RH</td>
</tr>
<tr>
<td>Altitude</td>
<td>Not applicable</td>
<td>0 to 3048 m (0 to 10,000 ft)</td>
</tr>
</tbody>
</table>

**NOTE:** These values are based on preliminary data. See [www.hp.com/support/ljcp1210series](http://www.hp.com/support/ljcp1210series) for current information.
Electrical specifications

**WARNING!** Power requirements are based on the country/region where the printer is sold. Do not convert operating voltages. This may damage the printer and void the product warranty.

<table>
<thead>
<tr>
<th>Item</th>
<th>110-volt models</th>
<th>220-volt models</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power requirements</td>
<td>100 to 127 V (+/-10%)</td>
<td>220 to 240 V (+/-10%)</td>
</tr>
<tr>
<td></td>
<td>50 to 60 Hz (+/-2 Hz)</td>
<td>50 to 60 Hz (+/-2 Hz)</td>
</tr>
<tr>
<td>Minimum recommended circuit capacity</td>
<td>4.5 A</td>
<td>2.5 A</td>
</tr>
</tbody>
</table>

### Power-consumption specifications

**Table C-1  Power consumption (average, in watts)**

<table>
<thead>
<tr>
<th>Product Model</th>
<th>Printing</th>
<th>Ready</th>
<th>Sleep</th>
<th>Off</th>
<th>Heat output-Ready (BTU/hour)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Color LaserJet CP1210 Series printer</td>
<td>290</td>
<td>12</td>
<td>12</td>
<td>0.0</td>
<td>41</td>
</tr>
</tbody>
</table>

1. The power consumption reflects the highest values measured for color and monochrome printing when using standard voltages.
2. For both Letter and A4-size media, the printing speed is 8 ppm for color printing and 12 ppm for monochrome printing.

**NOTE:** These values are based on preliminary data. See [www.hp.com/support/ljcp1210series](http://www.hp.com/support/ljcp1210series) for current information.
Acoustic emissions

<table>
<thead>
<tr>
<th>Sound power level</th>
<th>Declared per ISO 9296</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing (12 ppm)$^1$</td>
<td>$L_{WAd} = 6.1$ Bels (A) [61dB (A)]</td>
</tr>
<tr>
<td>Ready</td>
<td>$L_{WAd} =$ Inaudible</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sound pressure level: bystander position</th>
<th>Declared per ISO 9296</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing (12 ppm)$^1$</td>
<td>$L_{pAm} = 47$ dB (A)</td>
</tr>
<tr>
<td>Ready</td>
<td>$L_{pAm} =$ Inaudible</td>
</tr>
</tbody>
</table>

$^1$ For both Letter and A4-size media, the printing speed is 8 ppm for color printing and 12 ppm for monochrome printing.

**NOTE:** These values are based on preliminary data. See [www.hp.com/support/ljcp1210series](http://www.hp.com/support/ljcp1210series) for current information.

Paper and print media specifications

For information about the supported paper and print media, see [Paper and print media](#) on page 13.

Skew specifications

The product has the following skew specifications:

- **Print engine** (cut-sheet paper): less than 1.5 mm (0.06 inches) over a 260-mm (10.24-inch) length
- **Print engine** (envelopes): less than 3.3 mm (0.13 inches) over a 220-mm (8.66-inch) length
D Regulatory information

- FCC regulations
- Environmental product stewardship program
- Declaration of conformity
- Safety statements
FCC regulations

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy. If this equipment is not installed and used in accordance with the instructions, it may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase separation between equipment and receiver.
- Connect equipment to an outlet on a circuit different from that to which the receiver is located.
- Consult your dealer or an experienced radio/TV technician.

NOTE: Any changes or modifications to the printer that are not expressly approved by HP could void the user’s authority to operate this equipment.

Use of a shielded interface cable is required to comply with the Class B limits of Part 15 of FCC rules.
Environmental product stewardship program

Protecting the environment

Hewlett-Packard Company is committed to providing quality products in an environmentally sound manner. This product has been designed with several attributes to minimize impacts on our environment.

Ozone production

This product generates no appreciable ozone gas (O₃).

Power consumption

Power usage drops significantly while in Ready/Sleep mode, which saves natural resources and saves money without affecting the high performance of this product. To determine the ENERGY STAR® qualification status for this product see the Product Data Sheet or Specifications Sheet. Qualified products are also listed at:


Paper use

This product’s manual duplex feature (two-sided printing) and N-up printing (multiple pages printed on one page) capability can reduce paper usage and the resulting demands on natural resources.

Plastics

Plastic parts over 25 grams are marked according to international standards that enhance the ability to identify plastics for recycling purposes at the end of the product’s life.

HP LaserJet print supplies

It’s easy to return and recycle your empty HP LaserJet print cartridges—free of charge—with HP Planet Partners. Multilingual program information and instructions are included in every new HP LaserJet print cartridge and supplies package. You help reduce the toll on the environment further when you return multiple cartridges together rather than separately.

HP is committed to providing inventive, high-quality products and services that are environmentally sound, from product design and manufacturing to distribution, customer use and recycling. When you participate in the HP Planet Partners program, we ensure your HP LaserJet print cartridges are recycled properly, processing them to recover plastics and metals for new products and diverting millions of tons of waste from landfills. Since this cartridge is being recycled and used in new materials, it will not be returned to you. Thank you for being environmentally responsible!

NOTE: Use the return label to return original HP LaserJet print cartridges only. Please do not use this label for HP inkjet cartridges, non-HP cartridges, refilled or remanufactured cartridges or warranty returns. For information about recycling your HP inkjet cartridges please go to http://www.hp.com/recycle.
Return and recycling instructions

United States and Puerto Rico

The enclosed label in the HP LaserJet toner cartridge box is for the return and recycling of one or more HP LaserJet print cartridges after use. Please follow the applicable instructions below.

Multiple returns (two to eight cartridges)

1. Package each HP LaserJet print cartridge in its original box and bag.
2. Tape up to eight single boxes together using strapping or packaging tape (up to 70 lbs).
3. Use a single pre-paid shipping label.

OR

1. Use your own suitable box, or request a free bulk collection box from the [http://www.hp.com/recycle](http://www.hp.com/recycle) or 1-800-340-2445 (holds up to eight HP LaserJet print cartridges).
2. Use a single pre-paid shipping label.

Single returns

1. Package the HP LaserJet print cartridge in its original bag and box.
2. Place the shipping label on the front of the box.

Shipping

For all HP LaserJet print cartridge recycling returns, give the package to UPS during your next delivery or pickup, or take it to an authorized UPS drop-off center. For the location of your local UPS drop-off center, call 1-800-PICKUPS or visit [http://www.ups.com](http://www.ups.com). If you are returning via USPS label, give the package to a U.S. Postal Service carrier or drop off at a U.S. Postal Service Office. For more information, or to order additional labels or boxes for bulk returns, visit [http://www.hp.com/recycle](http://www.hp.com/recycle) or call 1-800-340-2445. Requested UPS pickup will be charged normal pickup rates. Information subject to change without notice.

Non-US returns

To participate in HP Planet Partners return and recycling program, just follow the simple directions in the recycling guide (found inside the packaging of your new printer supply item) or visit [http://www.hp.com/recycle](http://www.hp.com/recycle). Select your country/region for information on how to return your HP LaserJet printing supplies.

Paper

This product is capable of using recycled papers when the paper meets the guidelines outlined in the *HP LaserJet Printer Family Print Media Guide*. This product is suitable for the use of recycled paper according to EN12281:2002.

Material restrictions

This HP product does not contain added mercury.

This HP product does not contain a battery.
Disposal of waste equipment by users in private households in the European Union

This symbol on the product or on its packaging indicates that this product must not be disposed of with your other household waste. Instead, it is your responsibility to dispose of your waste equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment at the time of disposal will help to conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where you can drop off your waste equipment for recycling, please contact your local city office, your household waste disposal service or the shop where you purchased the product.

Material Safety Data Sheet (MSDS)

Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example, toner) can be obtained by contacting the HP Web site at www.hp.com/go/msds or www.hp.com/hpinfo/globalcitizenship/environment.

For more information

To obtain information about these environmental topics:

- Product environmental profile sheet for this and many related HP products
- HP’s commitment to the environment
- HP’s environmental management system
- HP’s end-of-life product return and recycling program
- Material Safety Data Sheets

Declaration of conformity

according to ISO/IEC 17050-1 and EN 17050-1, DoC#: BOISB-0603-00-rel.1.0

Manufacturer's Name: Hewlett-Packard Company
Manufacturer's Address: 11311 Chinden Boulevard, Boise, Idaho 83714-1021, USA

declares, that the product

Product Name: HP Color LaserJet CP1215/CP1515/CP1518 Series
Regulatory Model: BOISB-0603-00
Product Options: All
Toner Cartridges: CB540A, CB541A, CB542A, CB543A

conforms to the following Product Specifications:

SAFETY: IEC 60950-1:2001 / EN60950-1: 2001 +A11

       EN 61000-3-2:2000 +A2
       EN 61000-3-3:1995 +A1
       EN 55024:1998 +A1 +A2

Supplementary Information:

This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

¹) The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

²) For regulatory purposes, these products are assigned a Regulatory model number. This number should not be confused with the product name or the product number(s).

Boise, Idaho 83713, USA

October, 2007

For Regulatory Topics Only:

European Contact Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-TRE / Standards Europe, Herrenberger Strasse 140, Böblingen, D-71034, Germany, (FAX+49-7031-14-3143)

USA Contact Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, ID 83707-0015, USA, (Phone: 208-396-6000)
Safety statements

Laser safety

The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration has implemented regulations for laser products manufactured since August 1, 1976. Compliance is mandatory for products marketed in the United States. The device is certified as a “Class 1” laser product under the U.S. Department of Health and Human Services (DHHS) Radiation Performance Standard according to the Radiation Control for Health and Safety Act of 1968. Since radiation emitted inside the device is completely confined within protective housings and external covers, the laser beam cannot escape during any phase of normal user operation.

**WARNING!** Using controls, making adjustments, or performing procedures other than those specified in this user guide may result in exposure to hazardous radiation.

Canadian DOC regulations

Complies with Canadian EMC Class B requirements.

« Conforme à la classe B des normes canadiennes de compatibilité électromagnétiques. « CEM ». »

VCCI statement (Japan)

この装置は、情報処理装置等電波障害自主規制協議会（V C C I）の基準に基づくクラスB情報技術装置です。この装置は、家庭環境で使用することを目的としていますが、この装置がラジオやテレビジョン受信機に近接して使用されると、受信障害を引き起こすことがあります。
取扱説明書に従って正しい取り扱いをして下さい。

Power cord statement (Japan)

製品には、同梱された電源コードをお使い下さい。
同梱された電源コードは、他の製品では使用出来ません。

EMI statement (Korea)

이 기기는 가정용으로 전자파적합등록을 한 기기로서 주거지역에서는 물론 모드 지역에서 사용할 수 있습니다.
Laser statement for Finland

Luokan 1 laserlaite

Klass 1 Laser Apparat


VAROITUS!

Laitteen käyttäminen muulla kuin käyttöohjeessa mainitulla tavalla saattaa altistaa käyttäjän turvallisuusluokan 1 ylittäville näkymättömälle lasersäteilylle.

WARNING!

Om apparaten används på annat sätt än i bruksanvisning specificerats, kan användaren utsättas för osynlig laserstrålning, som överskrider gränsen för laserklass 1.

HUOLTO


VARO!

Mikäli kirjoittimen suojakotelo avataan, olet alttiina näkymättömälle lasersäteilylle. Älä katso näkymättömälle lasersäteilylle laitteen ollessa toiminassa.

WARNING!

Om laserprinterns skyddshölje öppnas då apparaten är i funktion, utsättas användaren för osynlig laserstrålning. Betrakta ej strålen. Tiedot laitteessa käytettävän laseriodin säteilyominaisuuksista: Aallonpituus 775-795 nm Teho 5 m W Luokan 3B laser.
### Substances Table (China)

根据中国电子信息产品污染控制管理办法的要求而出台

<table>
<thead>
<tr>
<th>部件名称</th>
<th>有毒有害物质和元素</th>
<th>铅 (Pb)</th>
<th>汞 (Hg)</th>
<th>镉 (Cd)</th>
<th>六价铬 (Cr(VI))</th>
<th>多溴联苯 (PBB)</th>
<th>多溴二苯醚 (PBDE)</th>
</tr>
</thead>
<tbody>
<tr>
<td>打印引擎</td>
<td>X</td>
<td>O</td>
<td>X</td>
<td>X</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>控制面板</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>塑料外壳</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>格式化板组件</td>
<td>X</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>碳粉盒</td>
<td>X</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
</tbody>
</table>

**O**: 表示在此部件所用的所有同类材料中，所含的此有毒或有害物质均低于 SJ/T11363-2006 的限制要求。

**X**: 表示在此部件所用的所有同类材料中，至少一种所含的此有毒或有害物质高于 SJ/T11363-2006 的限制要求。

**NOTE:** 引用的“环保使用期限”是根据在正常温度和湿度条件下操作使用产品而确定的。
Symbols/Numerics

2-sided printing 32

A
accessibility features 2
accessories 83, 84
acoustic specifications 98
agreements, maintenance 92
alerts, setting up 44
altitude specifications 96
anticounterfeit supplies 50
authorized dealers 90
auto continue 48

B
background, gray 74
batteries included 102
bin, output
   capacity 2
   jams, clearing 71
   locating 3
black and white printing 77
blank pages, troubleshooting 80
booklets 26
buttons, control panel 4

C
cables
   USB, troubleshooting 80
calibrating color 47, 79
Canadian DOC regulations 105
canceling a print job 24
capacity
   output bin 2
card stock
   printing on 28
cartridges
   error messages 65
   non-HP 50, 64
   order message 65
   recycling 101
   replace message 65
   replacing 52
   status, viewing 44
   storage 50
   using when out of toner 51
   warranty 89
characters, troubleshooting 75
cleaning 55
color
   adjusting 36
   calibrating 47, 79
   Edge Control 37
   halftone options 36
   HP ImageREt 2400 38
   managing 36
   matching 39
   Microsoft Office Basic Colors
      palette 39
   print in grayscale 36
   printed vs. monitor 39
   sRGB 37, 38
   troubleshooting 77
   contacting HP 90
   contracts, maintenance 92
   contrast
      print density 47
   control panel
      lights and buttons 4
      locating 3
      settings 9
   status-light patterns 59
   counterfeit supplies 50
   country/region of origin 5
creases, troubleshooting 76
crooked pages 76
curled media 76
custom-size media 28
customer support
   maintenance agreements 92
   online 90
   service information form 94

D
declaration of conformity 104
density settings 47
Device Settings tab
   HP Color LaserJet CP1210
      Series Toolbox 46
disposal, end-of-life 102
documentation 86
dots per inch (dpi)
   HP ImageREt 2400 38
   specifications 2
dots, troubleshooting 73
downloading software
   printing system 7
dpi (dots per inch)
   HP ImageREt 2400 38
   specifications 2
   drivers
      help, Windows 23
      included 2
      settings 9, 10
      shortcuts (Windows) 25
      supported 8
      Windows settings 25
duplex printing 32

E
Edge Control 37
   electrical specifications 97
   end-of-life disposal 102
   Energy Star compliance 2
Index

A

cleaning 55

B

help, Windows printer drivers 23

H

Help tab
HP Color LaserJet CP1210 Series Toolbox 45
help, Windows printer drivers 23
HP Color LaserJet CP1210 Series Toolbox about 43
density settings 47
Device Settings tab 46
Help tab 45
Microsoft Office Basic Colors palette, printing 39

I

image quality
HP Color LaserJet CP1210 Series Toolbox 47
HP ImageREt 2400 38
print, troubleshooting 72
ImageREt 2400 2, 38
incorrect supplies error message 64
information pages 42
install supplies message 64
Instant Support Professional Edition (ISPE) 90
interface ports types included 2

J

jam recovery 48, 67
jam-access door, locating 3
jams common causes of 68
error messages 64
locations 67
output bin, clearing 71
paper path, clearing 70
Japanese VCCI statement 105

K

Korean EMI statement 105

L

labels printing on 28
landscape orientation, setting 30
laser safety statements 105, 106
letterhead printing on 28
light patterns 59
light print, troubleshooting 73
lightness faded print, troubleshooting 73
lights, control panel 4
lines, troubleshooting printed pages 73
location, setting HP Color LaserJet CP1210 Series Toolbox 48
loose toner, troubleshooting 74

M

maintenance agreements 92
maintenance agreements 92
material restrictions 102
Material Safety Data Sheet (MSDS) 103
media curled, troubleshooting 76
document size, selecting 29
pages per sheet 33
specification guide 86
supported sizes 15
wrinkled 76
media settings HP Color LaserJet CP1210 Series Toolbox 48
memory specifications 2
mercury-free product 102
Microsoft Office Basic Colors palette, printing 39
misprint error message 65
model number 5
multiple pages per sheet 33

N

n-up printing 33
Neutral Grays 37
noise specifications 98
non-HP supplies 50, 64

O

on/off switch 3
online help, Windows printer drivers 23
online support 90
operating environment specifications 96
operating systems supported 2, 8
order supplies message 65
ordering
supplies and accessories 84
ordering supplies
Web sites 83
orientation, setting 30
output bin
capacity 2
jams, clearing 71
locating 3
output quality
HP Color LaserJet CP1210 Series Toolbox 47
HP ImageRET 2400 38
print, troubleshooting 72

P
page too complex error message 65
pages
blank 80
not printing 80
printing slowly 80
skewed 76
pages per minute 2
pages per sheet 33
paper
curled, troubleshooting 76
document size, selecting 29
pages per sheet 33
specification guide 86
supported sizes 15
wrinkled 76
paper path
jams, clearing 70
paper settings
HP Color LaserJet CP1210 Series Toolbox 48
physical specifications 96
portrait orientation, setting 30
ports
types included 2
power connection, locating 3
power specifications 97
power switch 3
preprinted forms
printing on 28
print cartridge, settings 48
print cartridges
error messages 65
non-HP 50, 64
order message 65
recycling 101
replace message 65
replacing 52
status, viewing 44
storage 50
using when out of toner 51
warranty 89
print cartridges, accessing 3
print density settings 47
Print Document On 29
print media
supported 15
print modes
HP Color LaserJet CP1210 Series Toolbox 48
print quality
HP Color LaserJet CP1210 Series Toolbox 47
HP ImageRET 2400 38
settings 27
troubleshooting 72
troubleshooting page 79
printer drivers
help, Windows 23
supported 8
printing
booklets 26
canceling 24
on both sides 32
on card stock 28
on custom-size media 28
on envelopes 28
on labels 28
on letterhead 28
on preprinted forms 28
on special media 28
on transparencies 28
troubleshooting 80
printing system software 7
priority, settings 9
product registration 49
product settings
HP Color LaserJet CP1210 Series Toolbox 48
production code 5

Q
quality
HP Color LaserJet CP1210 Series Toolbox 47
HP ImageRET 2400 38
print, troubleshooting 72
R
rear door, locating 3
recycling
HP printing supplies returns and environmental program 102
reducing documents 29
registration, product 49
removing Windows software 10
repackaging the product 93
repetitive defects, troubleshooting 77
replace supplies message 65
replacing print cartridges 52
resizing documents 29
resolution
automatic reduction 48
features 2
HP ImageRET 2400 38
specifications 2
revision level 5
RGB settings 37, 38
S
safety statements 105, 106
scaling documents 29
scatter, troubleshooting 76
serial number 5
service
agreements 92
HP-Authorized Dealers 90
information form 94
repackaging the product 93
service agreements 92
service settings
HP Color LaserJet CP1210 Series Toolbox 48
settings
color 38
drivers 10
HP Color LaserJet CP1210 Series Toolbox 46
print quality 27
priority 9
shortcuts (Windows) 25
shipping the product 93
shortcuts 25
size specifications, product 96
sizes, media
  tray selection 22
skew
  specifications 98
skewed pages 76
sleep time, setting 48
smear ed toner, troubleshooting 74
software
  problems 81
  removing on Windows 10
  settings 9
  Web sites 7
  Windows 11
special media
  guidelines 18
special paper
  guidelines 18
specifications
  acoustic 98
  documentation 86
  electrical 97
  environment 96
  features 2
  model and serial number 5
  physical 96
  skew 98
specks, troubleshooting 73
speed
  print specifications 2
  spots, troubleshooting 73
sRGB settings 37, 38
status
  alerts 44
  viewing 44
status-light patterns 59
storing
  print cartridges 50
  product 96
streaks, troubleshooting 73
supplies
  counterfeit 50
  error messages 65
  incorrect error message 64
  non-HP 50, 64
  order message 65
  ordering 49, 83, 84
  recycling 101
  replace message 65
  status, viewing 44
support
  maintenance agreements 92
  online 49, 90
  service information form 94
supported media 15
SupportPack, HP 92
T
technical support
  maintenance agreements 92
  online 90
  service information form 94
temperature specifications 96
text, troubleshooting
  misformed characters 75
toner
  loose, troubleshooting 74
  scatter, troubleshooting 76
  smeared, troubleshooting 74
  specks, troubleshooting 73
  toner cartridges. See print cartridges
transparencies
  ordering 86
  printing on 28
tray
  settings 46
tray 1
  capacity 3
  jams, clearing 69
  locating 3
trays
  capacities 2
  jams, clearing 69
  locating 3
troubleshooting
  blank pages 80
  calibration 79
  checklist 58
  color 77
  curled media 76
  faded print 73
  jams 67
  lines, printed pages 73
  loose toner 74
  pages not printing 80
  pages printing slowly 80
  print quality 72, 79
  repetitive defects 77
  skewed pages 76
  text 75
  toner scatter 76
  toner smear 74
  toner specks 73
  USB cables 80
  wrinkles 76
types, media
  HP Color LaserJet CP1210
  Series Toolbox 48
  tray selection 22
U
  USB port
    locating 3
    troubleshooting 80
    type included 2
V
  vertical lines, troubleshooting 73
W
  warranty
    extended 92
    print cartridges 89
    product 88
  watermarks 31
  wavy paper, troubleshooting 76
Web sites
  customer support 90
  fraud reports 50
  Material Safety Data Sheet (MSDS) 103
  ordering supplies 83, 84
  software, downloading 7
Windows
  driver settings 10, 25
  driver supported 8
  help, printer-driver 23
  removing software 10
  software for 43
  versions supported 8
  wrinkles, troubleshooting 76